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Introducción al Proyecto CatGen 

¿Qué es el CatGen?

El CatGen es una poderosa solución para catálogos electrónicos, diseñado para  permitir tanto a pequeños como a medianos negocios desplegar ambos sitios web B2B y B2C de comercio electrónico, o simplemente sitios web informativos para su empresa o proyecto. Este software de fácil uso ofrece una gama de características y funcionalidad para construir, diseñar y manejar un sofisticado almacén en línea a solo una fracción del costo de otros sistemas de comercio electrónico.

El CatGen consiste en una aplicación de Windows donde puede escoger un estilo y la apariencia para su almacén, y manejar una información detallada del producto, así como fotos y opciones. Su catálogo puede ser creado y conservado sin estar conectado al Internet para aquello que tienen conexiones lentas o caras de internet.

Una vez que la información ha sido introducida a su aplicación local de CatGen , usted puede registrarse para una cuenta de hosting  de CatGen.com o de uno de nuestros socios de hosting, y crear su catálogo de web gratis (de hasta 15 páginas) con solo hacer dos clicks. También están disponibles servicios adicionales de valor agregado tales como un sitio web más grande, un nombre de dominio para su empresa, carro de compras, asistencia con la configuración de opciones de pago de sus envíos, y diseño de sitios web – mire nuestra  Tabla de Comparación de Cuentas (en el web) y la lista completa de características  del software de CatGen.

Tan pronto como abra una cuenta pagada, el nombre de su empresa aparecerá en el directorio de empresas de CatGen.com, y todos sus productos o servicios serán visibles para compradores que estén buscando en el CatGen.com global product catalog.

Si usted se registró para una cuenta pagada con un carro de compras, usted tendrá una capacidad completa para realizar comercio electrónico B2B y B2C y necesitará configurar las opciones de pago y envío.

Una vez que usted realice una venta, el CatGen le permite manejar sus órdenes en línea..

Beneficios del CatGen para Pequeñas y Medianas Empresas Internacionales (PYMES) 

El CatGen fue diseñado de principio a fin para las necesidades de exportadores de empresas medianas y pequeñas (PYMES). Algunas de las características aplicables son:

Un cliente que se sostiene solo que y puede ser utilizado para aventajar tanto en  condiciones pobres o caras de conexiones internet.

Interfaces de programa Multi-lingue (Inglés, Francés, Español, Gujarati y otros por llegar) y sitios web de múltiples-lenguajes (hasta dos idiomas simultáneos)

Horarios para múltiple fijación de precios, puntos FOB y control de visibilidad de precios para cada comprador registrado

Licencia de servidor de software del CatGen para patrocinar a proveedores en cada país, quienes podrán proveer servicios dirigidos a sus usuarios.

Interconexión al EBay – publicación del producto al EBay con dos clicks.

Adicionalmente CatGen.com está en proceso de desarrollar soluciones de envíos y pagos  desde los  países en desarrollo hacia los Estados Unidos y Europa. Este es un compromiso ambicioso que implica el asociarse con una gran variedad de empresas incluyendo artesanos, artistas, exportadores, diseñadores, importadores, mayoristas, bancos y proveedores de logística y embarques. Muchos de estos servicios vendrán en línea para finales del 2002. Para más información diríjase a nuestra Página de Socios en CatGen.com. 

¿Quién es responsable de CatGen y por qué lo estamos creando?

El Proyecto CatGen es una iniciativa de PEOPLink , Inc. ("PEOPLink"), una organización sin fin de lucro dedicada a entrenar y equipar a artesanos en el Mundo en Desarrollo para que utilicen el Internet y tecnologías relacionadas, como cámaras digitales. Para promocionar sus productos y mostrar su cultura y herencia.

Un equipo Multinacional de creadores de software y expertos en comercio electrónico  de Ecuador, India, Irlanda, Nepal, Rusia, y los Estados Unidos desarrollaron la plantilla y el software de CatGen  y continúan trabajando en versiones más avanzadas para ambos. Las subvenciones del sector público y donaciones generosas de particulares hicieron posible el Proyecto CatGen y conceden al equipo de creación del CatGen el lujo de enfocar sus esfuerzos en maximizar los beneficios del CatGen  hacia las PYMES, y no en último lugar.

En CatGen, nuestra misión es pemitir que las PYMES alrededor del mundo se beneficien del  comercio electrónico. Nosotros creemos que los beneficios del Internet deben estar disponibles para todas las personas en todos los países, y nuestra meta es asegurarnos que las persona más vulnerables, como mujeres y grupos indígenas no se queden atrás.   

Recursos del Web 

CatGen.com web site
Tabla de Comparación de Cuentas
Abrir una cuenta de hosting gratis 

Página de Socios de CatGen
Sumario Ejecutivo 
Sumario Técnico 
Support Information 
 

Características del Software y del Servidor 



La Plantilla del CatGen consiste en una aplicación de Windows y un servidor de comercio electrónico. El hosting en el CatGen es gratis para sitios web de hasta 15 páginas, más allá de eso usted podrá escoger de una variedad de planes económicos de hosting.

El programa CatGen ("Catalog Generator") es una aplicación gratuita de Windows que puede ser usada para manejar las ofertas de servicios o productos de una empresa. El CatGen es una herramienta completa creadora de webs, diseñada para el Mercado internacional B2B de exportación. Su facilidad de uso hace que cualquier persona pueda crear cualquier cosa  de un simple sitio web, a un portal de comercio electrónico completamente equipado. 
Características de Windows de CatGen:

Una herramienta creadora de web de función completa fuera de línea , que es extremadamente simple y fácil de usar 

Selección de plantillas para control de presentación  

Entrada simple de datos de producto  

Opciones flexibles ilimitadas de productos (tamaño, color) 

Funciones básicas  de edición de imágenes que automáticamente crean imágenes del tamaño de una uña, etc. 

Publicaciones de web automáticas, puede cargar un sitio con dos clicks 

Sitios de lenguaje múltiple (hasta 2 idiomas simultáneos)  

Soporte de instalación de caracteres de Código único  

Puede ingresar sonido y video clips en su sitio web, así como tipos de archivo adicionales (archivos pdf, etc.) 

Accesorios B2B como horarios múltiples de fijación de precios y puntos FOB,  y control de visibilidad de precios para cada comprador registrado  

Permite imprimir hojas de precios y catálogos a color en una impresora 

Importar información de producto de otros vendedores de CatGen (si usted pertenece a una tienda que vende productos al detal de otros vendedores de CatGen,  no tiene que reordenar los datos) 

Características de Seguridad. Catálogos con protección de clave que permitan a múltiples sitios de empresas compartir la misma computadora. 

Respaldo de su catálogo, importación de productos de otros catálogos, exportación de productos hacia otros catálogos o hacia archivos simples de texto

Sus datos son guardados en una base de datos estándar de Acceso MS, para que pueda tener acceso a ella por cualquier motivo incluso para escribir su propio reporte de clientes 

El CatGen puede ser también utilizado para crear un portal CatGen o un “Catálogo de Catálogos”.
Servidor de Comercio Electrónico CatGen 

El servidor de comercio electrónico CatGen consiste en una aplicación de Java, XML y php que corren en servidores de aplicación que obedecen a J2EE y en plataformas de fuente abierta de bajo costo como Apache y Linux. 

Características del Servidor de Comercio Electrónico CatGen 

Produce sitios Web registrables bajo su propio nombre de dominio (www.nombredelaempresa.com) con solo dos clicks 

Carro de compras , con selección de opciones de envío y pago  

Manejo de Ordenes en Línea 

Sincronización bidireccional de datos entre el cliente y el host, así que puede mantener su sitio web desde varias localidades o con varios empleados.  

Catálogo de catálogos (usted puede crear un portal de CatGen para los vendedores a quienes usted represente, y puede enlistar o importar productos de otros vendedores de CatGen) 

Acceso FTP a su sitio Web, y cuentas de correo electrónico 

Agrega automáticamente datos de sus productos a la página global de búsqueda de CatGen 

Los catálogos y sitios web no utilizan marcos o URLs no indexables para indexar a través de los mayores motores de búsqueda. Todos los sitios pagados son automáticamente indexados por los mayores motores de búsqueda dentro de los tres primeros meses de creación 


Las siguientes características se encuentran en la fase de diseño:

Interconexión a EBay enliste sus productos en  Ebay en solo pocos minutos 

Traducción humana o de máquina del sitio web (servicio con cargo adicional) Puntos adición de envíos desde países tercermundistas hacia los Estados Unidos y Europa  

Asistencia de diseño de producto(servicio con cargo adicional) 

Interconexión con los sistemas de adquisición de los compradores a través del estándar internacional ebXML de intercambio de datos 

Recursos del Web

Sitio web simple de CatGen 
Sitio web más sofisticado de CatGen 
Sitio web de Catálogo de Catálogos 
Documento de Sumario Técnico
 

Guía Rápida de Inicio



La mejor forma de comenzar con el CatGen es Tomar el Tour utilizando la Empresa de Demostración de CatGen (incluida en la instalación) y luego seguir el Tutorial.  

Si solo desea obtener un catálogo de muestra armado y corriendo en 10 minutos en CatGen.com, utilice el siguiente procedimiento: 

Registre una nueva empresa en http://catgen.com/vendor/register.jsp. 

Asegúrese que cumpla con los requerimientos del sistema, luego descargar e instalar CatGen 

Corra el CatGen, seleccione Crear Nueva Empresa, e ingrese la información de su empresa como se requiere (utilice el mismo código y clave de la empresa que escoja durante el proceso de registro).
 Seleccione su ícono de página de inicio en el árbol web [image: image1.bmp], haga un click con el botón derecho en la Página para Agrerar Línea de Producto, cambie el nombre de su línea de producto en la pestaña de Propiedades de Página, y Guarde.

Con su nueva línea de producto seleccionada, haga un click con el botón derecho en Agregar Nuevo Producto.  Ingrese la información requerida del producto (Código de nombre, Nombre del Producto, Descripción), seleccione una imagen si lo desea, y haga clic en Guardar. 

Seleccione Web > Crear/Actualizar Catálogo de Web.  Los datos de su empresa y producto serán cargados a su sitio web en CatGen.com 

Seleccione Web > Visualizar Catálogo de Web. Esto apuntará a su buscador a su sitio web de CatGen.com.
¡Eso es todo! Note que a pesar de que puede visualizar la página de inicio de su empresa en este URL, su empresa no aparecerá en la lista de empresas (http://catgen.com/buyer/searchvendor.jsp) y sus productos no aparecerán en el catálogo global (http://catgen.com/catalog/index.jsp) hasta que haya abierto una cuenta pagada. 

 

Instalación de CatGen 



Requerimientos del Sistema  

Si no está seguro de qué version de Windows tiene, haga click con el botón derecho en  el ícono  de Mi Computador en su escritorio. 

Windows 98SE, ME, XP, 2000

Usted ya tiene todos los componentes necesarios en su computador. Proceda a las instrucciones de instalación abajo indicadas.

Usted debe tener una cuenta de internet y una red de marcado instalada para crear y actualizar su catálogo de web. Para imprimir su catálogo de producto, usted necesitará una impresora, de preferencia a color. 

Windows 95, 98 (First Edition), y algunos NT 4.0

El CatGen requiere Internet Explorer 4.01SP1 o uno más alto, y Microsoft Data Access Components (MDAC) 1.5 o uno más alto. Algunas versiones anteriores de Windows necesitarán que estos componentes sean instalados manualmente.

El  MDAC es instalado con Internet Explorer 5.50 o uno mayor, así que la manera más fácil de hacer a su computador compatible con el CatGen es instalar el Internet Explorer más reciente desde www.microsoft.com/ie. Si usted ya tiene el Internet Explorer 4.01 SP1 o uno más alto, usted puede obtener el  MDAC de http://microsoft.com/data/download_25SP1.htm (alrededor de 7 MB). 

El CatGen le advertirá si usted no tiene componentes necesarios. Para ver qué version de Internet Explorer y MDAC tiene, usted tiene que correr el CatGen y seleccionar  Ayuda > Acerca de. 

 

Instalación

La instalación es muy clara. 

Asegúrese que cumpla con los requerimientos del sistema  

Conéctese al internet 

Descargue el programa de instalación de http://catgen.net/install/catgen.exe. Seleccione Correr desde Ubicación Actual. 

El programa de instalación de CatGen empezará. Haga click en Siguiente para instalar el CatGen en el directorio predeterminado.  

Haga click en Siguiente para escoger el grupo de programa predeterminado ("CatGen"). 

Haga click en finalizar para completar la instalación.

 

Instalación del CatGen 

Notas de Lanzamiento



V2.00.58 (Mar. 7/02)

Plantilla de Cambios (fuente, color, imagen de fondo)

Soporte de Código único

Documentación íntegra

Servidor que soporta a JBoss

V2.00.49 (Ene. 10/02)

Interconexión a Dreamweaver a Bug Fixes

V2.00.28 (Dic. 5/01)

Primer lanzamiento público de la plataforma CatGen 2.00  

Acuerdo de Licencia, Copyright, y Ninguna Garantía



Este es un acuerdo legal entre usted, el usuario final y  PEOPLink, Inc. http://peoplink.org; una corporación sin fin de lucro registrada en Kensington, MD, USA. Al instalar el Software CatGen (el "Software") usted acepta todos los terminos y condiciones de este acuerdo. El término "Software" incluye cualquier mejora, versiones modificadas o actualizaciones de el Software otorgado a usted por PEOPLink.

El software CatGen 1.00 fue fuente abierta y reside en Sourceforge, pero el software CatGen 2.00 es una completa reedición y ya no es una fuente abierta. Es muy probable que en el futuro PEOPLink lance el CatGen bajo licencia de fuente abierta.

Uso del Software de CatGen.

PEOPLink le otorga un derecho ilimitado para utilizar, copiar y distribuir el software de CatGen de los clientes en forma de objeto, proporcionado como para que no sea modificado de su versión original.   

Si usted desea utilizar el software host de CatGen en su propio servidor usted debe adquirir una licencia de PEOPLink. Estas licencias son muy poco costosas, y son mayoritariamente utilizadas para justificar la sustentación del proyecto de nuestros financistas. El PEOPLink/CatGen es un proyecto de software orientado a la comunidad y nosotros gustosamente proveemos un código de fuente a la organización deseando contribuir a la plataforma de CatGen. 

Créditos

Véase Página de créditos en CatGen.com 

Copyright 

© Copyright 2000 by PEOPLink, Inc. Todos los Derechos Reservados.  CatGen® y CatGen Platform son Marcas Registradas de PEOPLInk, Inc.

PEOPLink tiene los derechos reservados del software, http://peoplink.org y sus derechos de propiedad son sujetos a limitaciones y restricciones impuestos por el Acta de Derechos de Autor de los Estados Unidos de América (título 17, código de los Estados Unidos) y provisiones de Tratado Internacional. Más allá, este  acuerdo de ninguna manera le otorga algún derecho de propiedad intelectual en el Software.  
Sin Garantía.

EL SOFTWARE CATGEN, LA PLATAFORMA DIGITAL DE COMUNICACIONES CATGEN, Y LOS SERVICIOS RELACIONADOS SON PROPORCIONADOS POR PEOPLINK “COMO ES” Y CUALQUIER GARANTÍA EXPRESA O SUGERIDA, QUE INCLUYE PERO NO SE LIMITA A LAS GARANTÍAS SUGERIDAS DE MERCATILIZACIÓN Y ACOPLAMIENTO PARA UN PROPÓSITO EN PARTICULAR SON RECHAZADAS. EN NINGÚN CASO PEOPLINK O LOS CONTRIBUYENTES SERÁN RESPONSABLES DE CUALQUIER DAÑO FORTUITO, DIRECTO O INDIRECTO, ESPECIAL, EJEMPLAR O CONSECUENTE (QUE INCLUYE PERO NO SE LIMITA A OBTENCIÓN DE BIENES O SERVICIOS SUSTITUTOS; PÉRDIDAS DE USO, DATOS O GANANCIAS; O INTERRUPCIÓN DEL NEGOCIO) DE ALGÚN MODO OCASIONADO Y EN CUALQUIER TEORÍA DE RIESGO, YA SEA EN CONTRATO, RIESGO ESTRICTO O AGRAVIO (INCLUSO NEGLIGENCIA U OTRO) SURGIDO DE ALGUNA FORMA FUERA DEL USO DE ESTE SOFTWARE, AÚN CUANDO SEA ADVERTIDO DE LA POSIBILIDAD DE DICHO DAÑO.  

Tome el Tour de CatGen  



Tomar el tour de CatGen es la forma más fácil de Familiarizarse con las características básicas del programa de CatGen.

La Empresa de Demostración de CatGen 

La empresa de demostración de CatGen ( código de empresa “DEMO”) está incluida en la instalación. En este tour usted explorará las diferentes características del CatGen buscando en el sitio web de la empresa DEMO en su computador local. 

Este tour tomará alrededor de 15-30 minutos. Después de haber terminado usted entenderá la mayoría de las características del software de CarGen y estará listo para crear su propio sofisticado sitio web de comercio electrónico.  



Primer paso: abrir la empresa DEMO  

 

Abrir la Empresa Demo 



 Inicie el Catgen seleccionando Start > Programs > Catgen > Catgen Client.  Aparece la caja de diálogo de login contenida en la pestaña de Bienvenida. 
[image: image133.png]
Crear nueva compañía
Abrir compañía

Una vez seleccionado "Demo", haga click en OK.  Aparece la caja de diálogo de login para la empresa DEMO.
[image: image134.png]=
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Codigo de Compañía

Nombre de la compañia

Clave

Haga click en el botón de Abrir. Esto abre la empresa de Demostración CatGen.

 



Siguiente paso: Navegar en las páginas web de la Empresa de Demostración  

Navegar en las Páginas Web de la Empresa Demo 



El sitio web de una empresa puede ser tomado como una jerarquía de páginas web, con la página de inicio a la cabeza de la jerarquía.

El CatGen muestra las páginas del sitio web de la empresa  en una ventana llamada Arbol Web (la ventana de la izquierda). Cada item en el árbol web representa una página. Cuando usted hace click en una página del Arbol Web, esta se abre y se exhibe en el panel de contenido (la ventana de la derecha).

Navegando las páginas web de la Empresa de Demostración de CatGen

Haga click en el ícono de Página de inicio [image: image2.bmp] en el panel del Arbol Web. Usted también puede ver la página de inicio haciendo click en el ícono de Mis Páginas en la barra de tareas [image: image3.bmp]. 

La forma de la página web para la página de inicio de la Empresa de Demostración de CatGen aparece en la pestaña Preview(Presentación Preliminar) del panel de contenido, como se indica abajo. Usted puede crear varios tipos de páginas web, su página de inicio es una de ellas (que es creada por defecto en cada sitio web). Más información acerca de ello en tipos de páginas web. 
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Archivo / Editar / Catálogo / Web / Reportes / Ver / Ayuda

Propiedades de página / Enlaces / Diseño / Código fuente / Vista Preliminar

La pestaña de Preview muestra la página web exactamente como aparecerá en el sitio web publicado. Note que el Panel de Contenido tiene cinco pestañas: Propiedades de Página, Vínculos, Diseño, Código de Fuente y Vista Preliminar. Usted explorará las varias Visiones de Páginas en la siguiente sección. 

3.   Haga click en Acerca de la página, Contácte la página, o Página de Políticas en el Arbol Web.  Estas páginas son creadas por defecto en cada sitio web de CatGen.  Usted siempre puede borrarlas (hacerlas invisibles) si lo desea más adelante. 4.   Haga click en en la página Story: Babila Veronica. 
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Todas las Historias / Propiedades de la historia / Enlaces / Diseño / Código fuente / Vista preliminar
Una página de historia es un tipo de página especial que tiene información acerca de un artista, proceso de manufacturación o impacto ambiental de un producto, o sino información general de la empresa. Una página de historia puede ser adjunta a cualquier otra página – en este caso, la historia de "Babila Veronica" es adjuntada a la página de inicio la cual crea un vínculo a la página Story:Babila Veronica en la sección de Historias Relacionadas de la página de Inicio. Una página de historia puede también ser asociada con una línea de producto o página de producto. Más información en Historias.

5.
Ahora haga click en la página de African Drums junto al ícono de Línea de Producto  [image: image4.bmp].
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Propiedades de la página / enlaces / Diseño / Código fuente / Vista preliminar
La página de African Drums es un tipo de página llamada un Producto de Línea. Una página de Línea de Producto o contiene otros pruductos ( como en este caso) u otras Líneas de Producto. La pestaña de Preview de una línea de producto siempre muestra los productos que están incluidos en la línea de productos.

6.    Ahora haga click en el signo de más (+) que está delante de African Drums en el panel de Arbol Web.  La sección se expandirá para mostrar los productos contenidos en la línea de productos de "African Drums". 
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A continuación haga click en el Producto Spider Drum. El producto Spider Drum aparecerá en el panel de Contenido. 

Haga click en las otras páginas en el árbol web para ver el efecto. 

Sumario

Las páginas de su sitio web están organizadas en una estructura jerárquica llamada Arbol Web. 

Usted puede navegar en el Arbol Web haciendo click en cada página, activando la pestaña Preview. Nota: también puede navegar en las páginas siguiendo los vínculos en la pestaña Preview como se describe en la sección Navegando el Sitio Web. 

Las páginas de su sitio web pueden ser de diferentes tipos 

	[image: image6.bmp]
	Su Página de Inicio.  

	[image: image7.bmp]
	Una página de información 

	[image: image8.bmp]
	Una página de historia (como una página de información, excepto que puede ser vinculada simultáneamente a varias páginas diferentes)

	[image: image9.bmp]
	Su página de contacto (su información de empresa de contactos)

	[image: image10.bmp]
	Una página de Línea de Producto, la cual contiene Productos u otras Líneas de Productos

	[image: image11.bmp]
	Una Página de Producto. Una página de Producto siempre está vinculada a un producto en su base de datos  


4.   Usted puede acceder a diferentes vistas en cada página(ver siguiente sección)

Siguiente paso: Explorar Vista de Página
Explorar Vistas de Página



En esta sección exploramos los diferentes vistas disponibles para usted en cada una de sus páginas web. 

Explorando Vistas de Página

Haga click en el ícono de Página de inicio [image: image12.bmp] en el listado de panel del Web. Esto mostrará la Vista Preliminar (o pestaña de Vista Preliminar ) de su página de inicio.  

La pestaña de Vista Preliminar muestra la página exactamente como aparecerá en su sitio web publicado.

Haga click en la pestaña de Propiedades de Página. 
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Propiedades de la página

Identificador de página

Nombre

Keyword Meta Tags (Palabras clave)

Description Meta tags (Descripción)

Visibilidad
Plantilla Master
Cuerpo de plantilla
¿Protegido po clave?
Generar lista de productos

Esta pestaña es donde usted pone el nombre de su empresa, sus plantillas de página y otros varios arreglos, los cuales son descritos más detalladamente en los tópicos de Pestaña de Propiedades de Página y Plantillas de Página. 

Haga click en la pestaña de Vínculos.
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Enlaces
Principal / Navegar / Historia / Productos / Otros
La pestaña de Vínculos es donde usted reemplaza (si es necesario) los hipervínculos de falla que son puestos en la página web ( en la barra de navegación a mano izquierda).  La pestañas de Principal, Buscar, Historia, Producto, Otros se remiten a la sección de la página donde están los vínculos.   
Armar vínculos es estrictamente opcional, ya que la sección de vínculos de cada página es automáticamente armada por la posición de cada página en el Arbol Web, por defecto. Más información en Pestaña de vínculos...

Haga clic en la pestaña de Diseño.
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Diseño
La pestaña de Diseño es donde usted ingresa y formatea texto, imágenes y otros contenidos html para que aparezcan en su página web. Note que ciertos tipos de páginas (páginas de productos y páginas de línea de productos) ya tienen un contenido de falla, pero usted todavía puede agregar contenido a estas páginas en la pestaña de Diseño. Más información en Pestaña de diseño... 

Haga click en la pestaña de Código Fuente.
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Código Fuente
Inglés / Español

Grabar / Ayuda

La pestaña de Código Fuente es donde usted visualiza la fuente html actual que está en su página. Usted no necesita conocer el lenguaje html para formatear su página web, pero si lo sabe le ayudará a hacer páginas web más atractivas. Más información en    Pestaña de Fuente... 

Sumario 

Usted controla el contenido y apariencia de cada una de sus páginas web dentro de las 5 Vistas de Página (o pestañas) 

La pestaña de propiedades de página es donde usted fija el nombre de su página y otras propiedades de las páginas, como el estado de visibilidad y plantillas de página (apariencia) 

La pestaña de Vínculos es donde usted corrige los vínculos de falla que son colocados en las páginas de su sitio web. Usted normalmente no necesita hacer esto.

La pestaña de Diseño es donde usted agrega contenido (texto, imagines y formatea) a sus páginas. Cierto tipo de páginas (páginas de productos y páginas de línea de productos) tienen contenido por defecto, pero usted siempre puede agregar contenido sobre o debajo del contenido generado automáticamente de estas páginas.

La pestaña de Fuente le otorga otra manera en la que puede controlar el formateo de su página (si usted conoce el html y está buscando un formateo más sofisticado).

La pestaña de Vista Preliminar es donde usted puede tener una vista previa de su trabajo.



Siguiente Paso: Navegando el Sitio Web
Navegando el Sitio Web  



Esta sección le dará una visión general de los hipervínculos que el CatGen coloca en su sitio web, y de cómo organizar su sitio web.

Siguiendo Vínculos en la pestaña de Vista Preliminar

Haga click en su Página de Inicio [image: image13.bmp] en el Arbol Web  y asegúrese que la pestaña de  Vista Preliminar esté activa.

Usted puede seguir cualquier vínculo en la pestaña de vista preliminar haciendo click en él. Intente hacer clic en Acerca de la página. 
En la sección de vínculos de su página de inicio, usted ve vínculos hacia las páginas de Acerca de, Contacto y Políticas. 
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Acerca de 
Contacto
Políticas
El motivo de esto es que las páginas Acerca de, Contacto y Polítcas son colocadas directamente bajo su página de inicio. 

En la sección de Navegar de de las página, hay vínculos a las páginas de línea de productos African Drums, Artistic stools, y Accessories.
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Todas las páginas de línea de productos  que son subdirectorios de la página de inicio, aparecen en la Sección de Navegar. Si usted hace click en la página de Accesorios o en cualquiera de las páginas de línea de productos, se irá a la página, por supuesto, pero note como la línea de producto se vincula en la expansión de la página o de lo contrario se cambia a negrilla:
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Note que la línea de productos Accesorios (que contiene otras dos líneas de producto,  Accesorios de Cocina y Accesorios de Oficina), está ahora expandida. 

En la sección de Historias Relacionadas de su página de inicio, hay un vínculo a la página Story: Babila Veronica. 


[image: image16.png]Related Stories





Esto sucede porque la página Story: Babila Veronica es una subpágina de la página de inicio. En cualquier momento en que usted quiera hacer un vínculo de Historias Relacionadas en una página, todo lo que tiene que hacer es arrastrar y colocar una Historia del Formulario de Historias en el web tree. 

Ahora haga click en African Drums. El panel de contenidos se llena con los dos productos Spider Drum y African Celebration Drum. 
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Propiedades de la página / enlaces / Diseño / Código fuente / Vista preliminar

El motivo de esto, usted lo adivinó, es porque los dos productos Spider Drum y African Celebration Drum son subpa´ginas de la página de línea de productos  African Drums.  Más información en Productos... 

Sumario 

Los hipervínculos en cada página de su sitio web son organizados por sección (Vínculos, Búsqueda, Navegar, Historia Relacionadas, Productos Relacionados). 

Usted controla los hipervínculos modificando la estructura de  árbol web. Las páginas de su sitio web normalmente tienen vínculos a cada una de sus sub páginas 

Usted puede corregir cualquier hipervínculo colocado en la página con la Pestaña de Vínculos de la página (pero esto normalmente no es necesario). 

Usted puede arrastrar y colocar páginas del Formulario de Historias o del Formulario de Productos en su árbol Web.  Esto agregará respectivamente un vínculo de “Historias Relacionadas” a la página, o sino un producto una página de línea de producto. 



Siguiente sección: Ver Productos
Ver Productos 



La información de detalles del producto permanece en los formularios de Todos los Productos y Productos. Los productos pertenecen a una o más Líneas de Producto; usted agrega un producto a una línea de producto arrastrando y colocando desde el formulario de Todos los Productos árbol web
Visualizando detalles del producto
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Productos

Todos los productos / Producto

Nuevo  / Modificar / Eliminar /

Importar desde otro vendedor

Productos:

Imágenes / basico / Especificaciones / Envío / Precios / Imagnes adicionales / Imagen full tamaño
Seleccione Catalog > Products de la barra de menú de CatGen o haga clic en el ícono de producto en la barra de tareas
Aparece el formulario de Todos los Productos. 
El formulario de Todos los Productos muestra todos sus productos. Usted puede clasificar por Código de Producto o Nombre de Producto haciendo click en el encabezado correspondiente en el formulario. Más información  Formulario de Todos Los Productos...

Seleccione el producto Spider Drum y haga click en la pestaña de producto.  Note que el formulario de producto contiene 6 pestañas: Imágenes, Básico, Aspectos, Envío, Precios, Adicional. Sólo la pestaña de Imágenes consiste de Imágen Principal, Imágen Adicional e Imagen de Tamaño Completo 
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3.    Haga click en la pestaña de Imágenes.

El CatGen le permite introducir los siguientes tipos de imágenes:

	Imagen Principal 
	Imagen del producto principal que aparece en la página de producto. Por defecto, esto es dimensionado a un tamaño máximo (alto o ancho) de 240 pixels. Usted puede cambiar esto en su  Configuración de Empresa 

	Imagen del Tamaño de una Uña 
	Imagen del tamaño de una uña que aparece en las páginas de su línea de productos. Por defecto esto es dimensionado a un tamaño máximo de 120 pixels. Usted puede cambiar el montaje defectuoso en su página  Configuración de Empresa

	Imagen de Tamaño Completo 
	Por defecto, la imagen que usted ingresa para su producto es guardada como una “imágen de tamaño completo”(a menos que ya sea menor a 240 pixels en un lado). Si un producto tiene una imagen de tamaño completo, puede ser vista en su sitio web haciendo click en la imagen principal en su página de producto. Usted escoge si desea o no guardar una imagen de tamalo completo para cada producto en su página de Configuración de Empresa

	Imágenes Adicionales 
	 Usted puede ingresar imagines adicionales para su producto. Ellas aparecerán en su sitio web como vínculos directamente debajo de su imagen principal.


Para más información véase el tópico Imágenes de producto.

4.   Explore las otras pestañas de las pestañas de formulario de Producto Básico, Aspectos  y           Envío. La mayoría de las pestañas de productos se explican solas.

 Haga click en la pestaña de precios.
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La pestaña de precios es uno de los formularios más difíciles de entender de CatGen, pero usted puede mentalizarlo como dividido en dos secciones. La sección de arriba de la pestaña de precios es donde usted coloca sus diferentes opciones de producto (SKUs individuales), si son aplicables. En el caso de un “Producto Normal” (en otras palabras un producto sin opciones), solo hay una línea con la cantidad en stock, número de SKU, y código Armonizado de Tarifa (generalmente necesitará el Código Armonizado de Tarifa de su producto para propósitos de exportación, para más información véase Entrenamiento de exportación de CatGen).

La sección de abajo es donde usted ingresa los precios de cada SKU individual o ítem de stock. Si usted tuvo más de un item SKU (por ejemplo un producto en colores rojo y verde, o un producto que puede ser vendido individualmente o en juegos de 4), usted puede ingresar precios para cada ítem. Cada ítem a su vez puede tener varios precios ya que usted tiene un   Programa de Precios. También puede ingresar precios de descuento por volumen de compra especificando una cantidad mínima de orden. Para más información ver los tópicos Formulario de Precios de Producto y Programas Múltiples de Precios 

La pestaña de Adicional es donde usted especifica características adicionales del producto o nombres de campo, definidos por usted (como ISBN o código de proveedor).  Usted define estos  campos adicionales en la pestaña Campos Adicionales del formulario de Montaje del Programa. Usted puede definir campos que desee que sean visibles únicamente para usted ( así como precio de compra o comisión de vendedor), o campos que desee que sean visibles en su sitio web.     

Sumario

Usted puede ver todos sus productos desde el formulario de Todos los Productos,  haciendo click en el ícono de Producto en la barra de tareas. Usted agrega productos a las líneas de productos arrastrando y colocando desde el formulario de Todos los Productos hacia el árbol Web 
Sus imagines de producto deben ser de tan alta calidad como pueda hacerlas (véase la sección Imagen Digital) y deben estar disponibles en varios tamaños. Usted puede adjuntar cuantas imagines quiera a un producto.

La pestaña de precios es donde usted ingresa opciones de producto, si los hay  (diferentes tamaños y colores), y precios. Un producto puede tener varios precios ya que usted tiene un Programa de Precios, y puede controlar cual de sus compradores tiene visibilidad a cada programa de precios. También puede poner precios de descuento por volumen de compra en este formulario.

La pestaña de Adicional es donde usted define características adicionales de producto. 


Siguiente tópico: Ver Historias
Visualizando historias 

Seleccione Catalog > Stories, o haga click en el ícono de historias en la barra de tareas[image: image18.bmp] . 

Historias
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Todas las historias / Propiedades de la historia / Enlaces

Nuevo / Modificar / Eliminar 

El formulario de Todas Las Historias muestra todas las páginas de Historia que haya creado. Más información en Historias... Para tener una Vista Preliminar de la historia, Seleccione Story: Babila Veronica.  Esto resaltará la historia en el web tree. Haga click en la historia en el web tree para mostrar la Pestaña de Vista Preliminar. 
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Sumario

Una Página de Historia es tipo específico de página que puede documentar información de la empresa, información de artistas, proceso de manufacturación, impacto ambiental, etc., de su empresa o producto.   
Usted puede vincular historias a cualquier otra página (arrastrando y colocando desde el Formulario de Todas las Historias hacia el árbol Web), el cual tiene el efecto de agregar un vínculo a la sección de Historias Relacionadas de la página web.



Siguiente Paso: Ver Información de la Empresa
Ver Configuración de la Empresa



Visualizando información de la empresa para la Empresa de Demostración de CatGen 

Seleccione Catalog > Company o haga click en el ícono de la empresa en la barra de tareas[image: image20.bmp] 
. 
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Basico
Código de compañía / Nombre de la compañia
Clave

Refrescar información de la compañia

Sobreescribir

Este formulario contiene cinco pestañas: Básico, Adicional, Contacto, Dirección, Configuración. Toda la información de contacto de su empresa es guardada en el host durante el proceso de registro de cuenta de CatGen, y no puede ser actualizada desde el programa CatGen. Usted debe actualizar la información de su empresa en el host de su Panel de Control de Vendedores en CatGen.com.  

Ni más ni menos, para permitir a los usuarios que no tienen una conexión de internet crear un catálogo impreso de producto, es posible ingresar la información de su empresa en el formulario haciendo click en el botón de Corregir.  

Usted puede actualizar la información de su empresa (consígala de el host y guárdela en la base de datos de su empresa) haciendo click en el botón de Actualizar  Información de la Empresa.  

Haga click en la pestaña de Adicional en el panel de contenido. Note que el logotipo de su empresa puede ser insertado aquí.

Haga click en la pestaña de Configuración. 
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configuración:

Primer lenguaje del sitio web / segundo lenguaje del sitio web / Configurar email /No mostrar dirección de email
Mostrar direccion email
No mostrar dirección de email pero proveer “feedback box” / El sitio web tiene shopping cart / Mostrar imagen completa /  Tamaño predeterminado de imagen principal / Tamaño predeterminado de imagen pequeña /   Moneda predeterminada

Guardar             Cancelar             Ayuda

Este es el formulario desde el cual usted controla varios configuración de la empresa tales como el Segundo idioma de su sitio web (si lo hay), defectos de factores de dimensión  de sus imágenes, y si desea mantener una imagen del producto de tamaño completo. Para más información véase Configuración de la Empresa . 



Siguiente paso : Ver Configuración de Programa
Ver Configuración de Programa 



Sus configuración de programa incluyen ciertas cosas como el lenguaje del programa (lenguaje de archivo de Ayuda), configuración proxy (si está trabajando a través de un firewall), custom fields, y configuración de Respaldo.

Visualizando los configuración de su programa

Seleccione Edit > Program Settings.
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Configuración del programa:
Adicionar campos / campos invisibles / Respaldo

Lenguaje / Conección

Explore las diferentes pestañas del formulario de Configuración de Programa. Más información en Configuración de Programa... 

 

Siguiente paso: Correr Reportes
 

Correr Reportes de Producto



Usted puede generar catálogos impresos de productos y hojas de precios desde su programa CatGen. De esta forma CatGen puede ser una herramienta importante de manejo y ventas, aún cuando usted no esté listo para hacer un sitio web, y le puede ahorrar dinero evitando costos de impresión para catálogos de productos de corto recorrido o catálogos hechos para un cliente específico. 

Visualizando Reportes de la Empresa de Demostración de CatGen 

Seleccione Reports > Product Summary > All Products de la barra de menú de CatGen.

El Reporte conciso de Sumario de Producto aparece en el panel de Contenido como se muestra en la figura de abajo. 
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Anterior / Proximo / Ayuda
Seleccione Reports > Product Details > All Products de la barra de menú de CatGen. 

El Reporte para Clientes del Detalle de Productos de todos los productos en la base de datos de la Empresa de Demostración de CatGen aparece en el panel de Conrenido. Esto se muestra en la figura de abajo. 
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 Anterior / Proximo / Ayuda

Seleccione Reports > Product Catalog > All Products de la barra de menú de CatGen. 

El Catálogo de Producto para la Empresa de Demostración de CatGen aparece en el panel de contenido como se muestra en la figura de abajo. 
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Siguiente Paso: Visualizando el catálogo web publicado
 

Visualizando el Catálogo Web Publicado



El publicar su Catálogo Web significa transferir la información del producto e historias desde su software de CatGen hacia el host de CatGen ( www.catgen.com ). 

 Una vez que haya registrado su empresa en CatGen.com, ingresado su información de producto y creado localmente su sitio web, la publicación es una operación automática que puede llevar de solo pocos minutos a varias horas, dependiendo de la velocidad de su conexión y de su número de productos. Sin embargo, la próxima vez que publique su sitio, solo los productos o páginas nuevas o cambiadas se cargarán, así que la operación será mucho más rápida.  

El Ctálogo Web para la Empresa Demo ya ha sido publicado. Por razones de seguridad, la clave de la Empresa Demo ha sido removida.  The web Catalog for the Demo Company has already been published.  

Visualizando el catálogo web publicado  

Conéctese al Internet. 

Seleccione Web > View Web Catalog en catgen.net 

¡Felicitaciones! Usted a completado el tour de CatGen. Ahora debe tener suficiente información para crear su catálogo web, pero si lo desea, el Tutorial le guiará paso a paso por el proceso más detalladamente. 

Iniciar el Tutorial



La sección Tomar el tour le dio una revisión de las características de CatGen navegando en las páginas web de la empresa de Demostración de CatGen. En esta sección, se le dará instrucciones paso a paso para crear su propio catálogo CatGen. 


Primer Paso: Registrar el código de su empresa .

 

Registre Su Empresa en CatGen.com



Se recomienda que registre una empresa en CatGen.com antes de empezar a crear su catálogo web. Esto evitará problemas después, pues usted debe tener un Código de Vendedor único en el sistema CatGen para poder publicar su catálogo web. 
No cuesta nada registrar un código de vendedor, y una vez que haya hecho esto, usted podrá tener acceso a  su Panel de Control de Vendedor en CatGen.com para poder cambiar opciones de cuenta, agregar un carro de compras o cuenta de correo electrónico a su sitio, etc. 

Su Código único de Vendedor sirve como el URL para su página de inicio, por ejemplo  www.catgen.com/demo (el código de vendedor de este sitio web es "DEMO"). Si usted abre una cuenta pagada en CatGen.com, también podrá tener su propio nombre de dominio señalando su sitio web catgen. 

Registrando su empresa en CatGen.com

Vaya a http://www.catgen.com/vendor/register.jsp
El formulario de Registro de Empresa aparece.

Escriba su código de empresa escogido en el cuadro de Código de Empresa.

El código de la Empresa puede contener de 4 a 20 letras o números (A-Z0-9) y debe ser único. Escoja con cuidado su código de empresa, ya que será parte del URL para su página de inicio. Su código de empresa NO es sensible al caso (por ejemplo “comp1” es lo mismo que “COMP1”). 

Elija una Clave que pueda recordar fácilmente pero que sea difícil de descifrar para otros. Su clave SI es sensible al caso.

Ingrese todos los otros campos requeridos, en particular su dirección de correo electrónico.  
Haga click en ingresar. 

Una nueva cuenta de CatGen sera creada. Ahora usted está listo para crear y publicar su catálogo web.



Siguiente Paso: Crear una empresa nueva en el software de CatGen 
Crear un Nueva Base de Datos de la Empresa en Catgen.


La primera cosa que necesita hacer después de iniciar el programa CatGen es crear una nueva empresa. Esto creará el archivo de base de datos que guardará todas sus páginas e información de productos. Las páginas web y productos de esta base de datos serán eviados al host de CatGen cuando publique su catálogo. Esto se encuentra explicado más allá en el tópico Sincronización de Base de Datos. 

Creando una Nueva Empresa 

Abra el software de CatGen desde  Start menu > Program > CatGen > CatGen client. 

Si usted ya ha creado su empresa, escójala del cuadro de selección. Caso contrario si usted ha registrado previamente su empresa en CatGen.com aparecerá un diálogo Crear Nueva Empresa desde Registro de Web. Usted solo tiene que ingresar su clave, hacer click en Crear y proseguir al paso 4 de abajo.
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Registrar Nueva compañía en Web 

Código de compañía/Nombre de la compañía/Clave 

Crear / Cancelar / Ayuda

Si no logra conseguir el Crear Nueva Empresa desde el formulario de Registro Web, seleccione Crear Nueva Empresa y luego ingrese el exactamente el mismo código de Empresa, nombre de Empresa y Clave que usó durante el proceso de registro en el web y haga click en Crear.
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Nueva Compañia:
Código de compañia
Nombre de Compañía
Clave
Confirmar clave

Nota: No se requiere que registre su empresa para usar el CatGen (es más, usted puede usar el software de GatGen aún cundo no tenga una cuenta de internet), sin embargo más adelante se facilitarán las cosas si usted registra su empresa primero. 

El diálogo de Escoger Plantilla y Estilo aparecerá. Esto está explicado en el siguiente tópico.



Siguiente paso: Escogiendo plantilla y estilo
Escogiendo Plantilla y Estilo



Un Estilo es un plano de un sitio web que arma el formato y apariencia de su sitio web. Cada estilo esta hecho de un juego de plantillas de CatGen (por ejemplo, la plantilla de Página de Inicio, la plantilla de Línea de Producto, la plantilla de Detalles de Producto).      El software de CatGen viene con una variedad de estilos básicos. Dentro de cada estilo usted puede controlar el color de Fondo, Fuente, y esquema de Color. Usted está impulsado a escoger una plantilla la primera vez que crea un sitio, pero la puede cambiar en cualquier momento con el comando Cargar Estilo. 

Las plantillas de CatGen utilizan XSLT (eXtensible Stylesheet Transformation Language)  y son muy poderosas. Para más detalles véase Introducción a Plantillas de CatGen. 

Escoja un estilo para su empresa 

Siga la instrucción en el tópico Cargar Estilo para escoger un estilo para su sitio web. Si usted está creando una nueva empresa, el diálogo de Cargar Estilo aparecerá automáticamente.
El sitio web para su empresa se abre mostrando su página de Inicio en la pestaña de Vista Preliminar del panel de Contenido.
   


[image: image25.png]Page Fopeties | Links | Desgn| Souce Cace. Preven |

=&

.
CIStems Shyam Nagar

Contact

By Keynord: =





A los paneles izquierdo y derecho se los refiere como panel de árbol Web y panel de Contenido respectivamente. Note que inicialmente su Página de Inicio estará en blanco, y que CatGen crea por defecto su página de Inicio, página de Contacto y página de Políticas.  



Siguiente Paso: Creando su página de Inicio y página de Políticas 
Creando su página de Inicio, página de Políticas y páginas de Información de la Empresa



Sus páginas de Inicio y Políticas son creadas en blanco inicialmente. Crear estas páginas es una de sus tareas más importantes. 

Editando su Página de Inicio

Si su web tree no está visible, seleccione View > Web Tree para hacerlo visible. 

Haga click en el ícono de Página de Inicio en el web tree [image: image26.bmp] .

Haga click en la pestaña de Diseño.

¡Comience a escribir! Usted puede agregar texto, imagines, vínculos a otras páginas en su sitio o vínculos a sitios externos, incluso objetos binarios, como se describe en el tópico Pestaña de Diseño. Usted se puede cambiar de adelante hacia atrás entre la  Pestaña de Diseño y la Pestaña de Vista Preliminar  para tener una vista previa de su trabajo.  Si usted conoce el html, usted puede trabajar en la Pestaña de Fuente. 

Usted puede agregar productos Caracterizados a su página de inicio arrastrando y colocando desde el Formulario de Productos hacia la página de inicio. Esto se describe más allá en el tópico Ingresando productos.

Es una muy buena idea el ingresar Keyword Meta Tags y Description Meta Tags en cada página que usted cree (especialmente ensu página de inicio y páginas de información). Para más detalles véase el tópico Poniendo Índice a su sitio web.

Haga click en Guardar. 

Página de Políticas de Edición

Utilice el mismo procedimiento de arriba. Véase Entrenamiento CatGen de Exportación en el web para el tipo de información que usted debe colocar en su Página de Políticas.

Creando nuevas Páginas de Información 

Casi cualquier empresa necesita crear páginas adicionales dando información de fondo de la empresa – por ejemplo, Noticias, Mensaje del Dueño, Informe de Misión, etc.  Para crear nuevas páginas de información que están vinculadas  a su página de inicio:

Seleccione su página de Inicio en el árbol web y luego haga click con el botón derecho en la Página para Agregar Información, o haga click en el ícono de Página de Información en la barra de tareas del árbol web [image: image27] 

Ingrese un nombre para la página en la pestaña de Propiedades de Página. Más información en Pestaña de propiedades de página... 

Ingrese sus Keyword Meta Tags y Description Meta Tags (ver arriba). 

Haga click en la pestaña de Diseño e ingrese su contenido (texto e imágenes). 

Haga click en Guardar



Siguiente Paso: Configurar configuración de la empresa
Configuración de la Empresa


Utilice estos formularios para armar los configuración de la empresa como su logotipo, tamaño de imagen defectuoso, si su sitio tendrá un carro de compras, y si va a mantener imágenes grandes de productos en su sitio web.  

La información de su empresa (nombre, dirección etc.) es guardada en el host. Si usted siguió el procedimiento recomendado y registró una empresa en el host antes de crear su primer catálogo, esta información debe haber sido transmitida automáticamente a la base de datos de su empresa local la primera vez que lo creó. Si no es así usted fácilmente puede actualizar la base de datos de su empresa local de la información que ingresó durante el proceso de registro. 
Cambiando la información de contacto de la empresa (nombre, dirección, etc.)

Seleccione Catalog > Company del menú de Catálogo.

Observe la información de su empresa en las pestañas de Básico, Adicional, Contacto, y Dirección.  Si necesita hacer algún cambio, haga click en el Panel de Control de Vendedor, actualice los campos en catgen.com, y luego haga click en Actualizar información e la empresa de la base de datos del host. 
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1. Si no logra registrar una empresa en catgen.com haga cIick en el botón Corregir, lo cual le permitirá ingresar la información de contacto de la empresa. Sin embargo tenga cuidado de que esta información se pierda si alguna vez publica su catálogo web. 
Ingresando el logotipo de la empresa

Haga click en la pestaña de Adicional en el formulario de la empresa. 

Haga click en Seleccione Logotipo, e ingrese un archivo de imagen de logotipo para su empresa. El logotipo de su empresa aparecerá en la parte superior de todas sus páginas web. Si usted no ha creado un logotipo de la empresa, usted puede ignorar este paso, o de lo contrario insertar una imagen de usted mismo, su lugar de negocios, o de su producto principal.       

Haga click en Guardar . 

Cambiando la configuración de la Empresa

Haga click en la pestaña de configuración.
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Si usted está creando un sitio web de múltiple-idioma, ingrese el Segundo Idioma de su sitio web. Se recomienda (pero no se requiere) que el primer idioma de su sitio web sea el Inglés, para beneficio de los compradores internacionales. 

Si usted desea que aparezca un botón de "Agregar al Carro" en las páginas de producto de su sitio web, ponga una X en el cuadro Sitio Web tiene un carro de compras.  Nota: esta opción funcionará en su sitio web solo si abrió una cuenta CatGen pagada en catgen.com.  

Marque con una X en el cuadro Guardar imagines de tamaño completo del producto si usted desea que los compradores puedan ver el tamaño completo de la imagen del producto en su sitio web. La imagen de tamaño completo del producto normalmente es una imagen grande (aproximadamente 640 pixels) que usted ingresa a catgen cuando está agregando productos. La imagen estándar de producto y la imagen del tamaño de una uña son obtenidas reduciendo la imagen de tamaño completo durante el ingreso de datos del producto.  Se recomienda guardar la imagen de tamaño completo del producto, pero requerirá tiempo adicional de transferencia de datos cuando publique su catálogo web.  

Usted puede cambiar el tamaño deficiente de la imagen principal de su producto y de la imagen de tamaño de uña si lo desea. Esto afecta los factores de dimensión de estas imágenes sólo cuando usted crea nuevos productos, y no cambiará el tamaño el tamaño de ninguna imagen de producto que usted ya haya ingresado.  

Ingrese una Moneda predeterminada para sus productos. Actualmente solo se sustentan Dólares Americanos (USD). En una futura versión de CatGen, usted podrá crear tantas monedas como Programas de Precios tiene.  

Haga click en Guardar. 



Siguiente Paso: Ingrese sus líneas de Productos 

Ingrese sus líneas de Producto



Una línea de productos es una categoría de productos que usted vende, suéteres, sombreros, o muñecas. Las líneas de productos pueden ser jerárquicas, por ejemplo usted puede vender dos tipos muñecas y crear una línea de producto para cada tipo bajo la líneas de producto “muñecas”. 

Creando una nueva Línea de Producto 

1.
Si el árbol web no está visible, seleccione View > Web Tree del menú de CatGen. 

2.
Seleccione su Página de Inicio en el árbol web para crear una línea de producto nueva, de alto nivel. Para crear una línea de producto de bajo nivel, seleccione la página de línea de producto para la cual usted desea agregar una nueva sub-categoría.  

3.
Haga click en el botón de Agregar Página de Línea de Producto [image: image30.bmp], o haga clic con el botón derecho en Agregar Nueva Línea de Producto.  Una nueva página de línea de producto será creada y la pestaña de propiedades de página de la nueva línea de producto se abrirá. La nueva línea de producto puede ser movida de arriba hacia abajo en el árbol web. Véase Trabajando con el árbol web para más información. 
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Ingrese el nombre de la nueva línea de producto en el campo de Nombre. Si usted está creando un sitio web de múltiple-idioma, también tendrá que ingresar el nombre en el segundo idioma.  

Ingrese los Keyword Meta Tags y Description Meta tags para cada línea de producto, como se describe en la sección Poniendo índice a su sitio web.  

Si usted ha creado plantillas adicionales, usted puede asignar cada línea de producto a una plantilla. Véase Introducción a plantillas CatGen para más información.  

La generación de una línea de producto desde un informe SQL se utiliza para poblar automáticamente la línea de producto desde la base de datos de su producto, utilizando cierto criterio como productos con cierto código de producto etc. Usted normalmente no utilizará esto a menos que tenga un sitio web muy grande. Véase    Preguntas SQL para más información.  

Si usted desea agregar información de fondo acerca de los productos en la línea de productos, cámbiese a Pestaña de diseño  e ingrese esta información en las secciones de Encabezado de Página o Pie de Página. (Alternativamente, usted puede crear una  Historia  acerca de los productos y vincularla a su página de línea de producto) 

Haga click en Guardar. 

Haga esto para cada una de sus líneas de producto. 



Siguiente Paso: Ingrese sus productos, y asígnelos a Líneas de Producto 
Ingrese sus Productos



Ingrese las imagines de sus productos

Seleccione una Línea de Producto en el árbol web y haga click con el botón derecho en Agregar Nuevo Producto. También puede seleccionar Catalog > Products para traer el Formulario de Todos los Productos , haga click en el botón de Nuevo, ingrese la información del producto como se describe abajo, y luego arrastre y coloque el producto desde el formulario de Todos los Productos a su línea de producto. 

La pestaña de imagines actualmente está seleccionada. La hoja de pestaña de imagines tiene sub-pestañas imagen Principal, Imágenes Adicionales e imágenes de Tamaño Completo. 
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Normalmente usted tomará una foto de su producto y permitirá que catgen genere todas sus imágenes (imagen Principal, imagen de Tamaño icono e imagen de Tamaño Completo) de esta única imagen. Para hacer esto. Haga clic en el botón de Seleccionar para la imagen principal, ingrese el nombre de archivo de su imagen, y asegúrese de que el cuadro Utilice la imagen principal para la de tamaño de incono esté seleccionado. 

Si usted tiene más imágenes que desee adjuntar a su producto, haga click en la pestaña de Imágenes Adicionales y luego haga click en Nuevo. 
Para más información sobre lo anterior véase Formulario de Imágenes de Producto.  Para información general acerca de imágenes digitales véase Conceptos de Imagen Digital. 

Ingresando Información Básica

Haga click en la pestaña en el Formulario de Productos. 
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Producto:

Código de producto  /  Nombre de Producto

Descripción

Historia del productio

Grabar / Cancelar /Ayuda

Ingrese el Código de Producto, Nombre de Producto, Descripción e Historia del Producto en los cuadros de texto provistos. Los campos requeridos están en rojo. Para más información véase Formulario Básico de Productos. 
Ingresando Especificaiones de Producto

Haga click en la pestaña de Aspectos en el formulario de Productos.
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Especificaciones:
Largo / Ancho / Unidades de dimensión
Profundidad / Dia / 
Peso / Unidades de Peso
Material / detalles del paquete
Color dominante / Palabras claves
Comentarios

Ingrese la información en los cuadros de texto provistos. Para más información véase Formulario de especificaciones del Producto. 

Ingresando Información de Envío

Haga click en la pestaña de Evío en el formulario de Producto.
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Envío:
Capacidad de producción mensual
Tiempo de preparación para envío
Localización del embarque
Fecha
Ingrese la Capacidad Mensual de Producción, Tiempo de Preparación para Enviar y Ubicación de Almacenamiento (si es aplicable) en los cuadros de texto provistos. Para más información véase Formulario de Envío de Productos.

Ingresando Precios
Haga click en la pestaña de Precios en el formulario de Producto.
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Precios:

Productos Normal / Producto con opciones / Un Especial
Color/disponibilidad/Código HTC /
Adicionar Línea / Borrar Línea / Optciones / Llenar tabla



Precio Destino/ precio calculcado/Precio/moneda
adcionar nuevo / Borrar linea /Recalcular
Si usted está ingresando un producto simple selecciones Producto Normal. Luego ingrese la Cantidad en Stock, Código de Tarifa Armonizada (si lo desea) y SKU (si lo desea) en la ventana superior. Ingrese el Programa de Precios, Precio, y cantidad mínima y máxima de la orden en la ventana inferior.

Si usted está ingresando un producto con opciones (como “Tamaño large” y “Tamaño Small”, o “Cant. C/U” o “Cant. Juego de 4”), haga clic en el botón de Opciones y siga las instrucciones en Formulario de Productos y Precios. 

Para más información sobre lo anterior, incluyendo cómo ingresar precios de descuento por volumen de compra, véase  Formulario de Productos y Precios, Programa Múltiple de precios, o Formulario de Programa de Precios.

Ingresando Información para Campos Adicionales y Campos Invisibles

Los campos adicionales son elementos no estándares de datos (los define usted mismo) que son visibles en su sitio web (por ejemplo “ISBN” si es un vendedor de libros). Si usted ha creado Campos Adicionales, ingrese los valores de estos campos en Formulario de Campos Adicionales. Usted define Campos Adicionales en Formulario de Configuración de Programa.  
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Adicional:
Campos visibles en el Web: Código Mfr / Name Mrf / Dirección Mrf
Campos invisibles en el Web: Localización Mrf / contacto Mfr

Los Campos Invisibles son elementos de datos que usted desea ingresar en su base de datos local, pero que no estarán visibles en su sitio web (por ejemplo Precio de Fábrica si usted es revendedor). Este formulario le permite ingresar tanto Campos Adicionales como Campos Invisibles.  

Haga click en el botón de Guardar.
Ingresando información adicional y de fondo acerca de sus productos

Usted puede ingresae información adicional acerca de sus productos (texto e imagines) en la Pestaña de Diseño de la página de producto ya sea en la secciones  Superior o Inferior de la Página. Usted puede querer, por ejemplo, mencionar otros productos relacionados, o describir el proceso de elaboración del producto. También puede hacer esto creando una Historua acerca del producto, pero esto requqerirá que el comprador web haga click en otra página. Si tiene información que solo se aplica a un producto, es mejor ingresarla en la pestaña de Diseño.  

Agregando el Producto a una Línea de Producto

Si usted ingresó los nuevos productos en el Formulario de Todos los Productos (En lugar de hacer click con el botón derecho en el árbol web) tendrá ahora que asignar cada producto a una o más líneas de producto. Un producto puede pertenecer a varias líneas de producto al mismo tiempo. 

Haga click en la pestaña de Todos los Productos en el formulario de Productos. 

Seleccione el producto creado recientemente, manteniendo el botón izquierdo del mouse presionado, arrastre el producto creado recientemente hacia el web tree y colóquelo sobre una página de línea de producto. 
Siguiente Paso: Cree una Historia acerca de sus productos. 
Cree una historia acerca de sus productos 



Las historia le dan vida a su empresa y sus productos. Las buenas historias exhiben a su empresa, producto o cultura  le ponen a usted y a sus productos “en contexto”. Puede utilizar las historias para contra sobre los orígenes de su empresa, sobre la gente fascinante que elabora sus productos, los materiales o procesos que utiliza, o acerca de cualquier otra cosa que agregue sazón a su empresa y sus productos. Las historias deben realzar a su empresa y/o  los productos con los que se asocian, así que trate de escoger temas, que interesen a sus clientes potenciales.    

Una historia puede ser asociada con cualquier número de otras páginas. Cada página que esté asociada a la historia tendrá un vínculo con ella en la sección de “Historias Relacionadas”  

Usted vincula una historia a una página arrastrando y colocando desde el formulario Todas la Historias hacia una página en el árbol web 

Ingresando una Historia

Haga click en el ícono de Historias en la barra de tareas [image: image36.bmp] y luego haga click en Nueva Historia. Alternativamente, seleccione una página en el árbol web y haga click con el botón derecho en Agregar Historia.
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Seleccione la Pestaña de Propiedades de Historia e ingrese el nombre de la historia,  Keyword Meta Tags, y Description Meta Tags. 

Haga click en la Pestaña de Diseño y luego ingrese la Historia utilizando el teclado y las herramientas de Diseño de la pestaña de Diseño.   

Si usted está creando un sitio web de múltiple idioma, usted tendrá que ingresar el nombre de la historia, y el texto de la historia, en cada idioma. 

Haga click en Guardar. 

Si usted ha creado la historia desde el formulario Todas las Historias, tendrá que arrastrar la historia a las páginas del árbol web. Usted “arrastra” una historia  seleccionándola en el formulario de Todas las Historias, manteniendo presionado el botón izquierdo del mouse, arrastrando el puntero sobre una página en el árbol web, y soltando el botón izquierdo del mouse.   



Siguiente Paso: Imprimir el Catálogo de Producto 

Imprimir el Catálogo de Producto



Siga los siguientes pasos para imprimir su catálogo de producto:

Seleccione Reports > Catalog del menú de CatGen. 

Su catálogo de productos aparece en el panel de contenidos.

Haga click en el botón de Imprimir en la barra de menú del panel de contenidos. 

El catálogo de producto se imprime. 



Siguiente Paso: Publique su catálogo web 

Publique su catálogo web 



Publicar su Catálogo Web significa transferir la información del producto y las historias que ha ingresado a su software de CatGen hacia el host de CatGen ( catgen.com) donde serán visibles en su sitio web. Más adelante se lo describe en el tópico Sincronización de Base de Datos. Cuando usted publica su catálogo web, solo los productos, páginas o imágenes nuevas o cambiadas, son cargadas.    

Como publicar su catálogo web

Asegúrese de que haya registrado el código de la empresa en catgen.com.

Conéctece al internet.  Nota: Si usted está trabajando a través de un firewall usted necesita configurar su configuración proxy en la pestaña de Conexión.

Seleccione Web > Create/Update Web Catalog. Aparece un cuadro de diálogo de Conéctese a Internet:
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Conectar:
Continuar / Cancelar / Opciones avanzadas / Ver log / Ayuda

Normalmente usted solo hace click en Continuar. Ciertas situaciones (como forzar una republicación de todas sus páginas) requerirán que usted seleccione una opción en Cuadro de diálogo de Opciones Avanzadas . 

A menos que se le instruya de lo contrario, el CatGen solo carga datos que usted haya cambiado. 

!Felicitaciones, usted ha publicado su catálogo Web! 

Siguientes pasos 

El vender y comercializar exitosamente sus productos en internet requiere varias  técnicas, de las cuales crear un catálogo web solo es la primera. Para más información  véase  Introducción al sistema de comercio electrónico CatGen. 

Introducción al sistema de comercio electrónico CatGen


Para poder convertirse en un exitoso “negociador en la Red”, usted tendrá que adquirir destrezas y experiencia en varias áreas. Está página es una lista de recursos para esas destrezas. Para una versión más actualizada véase la Página de entrenamiento de comercio electrónico de CatGen.com. 

La plataforma de comercio electrónico de CatGen es un sistema dinámico que está progresando diariamente con la ayuda de negocios, consultores y diseñadores de software, asociaciones de intercambio y cámaras de comercio, proveedores de logística, bancos, y otros, alrededor del mundo- para más información véase Página de Socios CatGen.com. Si no encuentra aquí o que está buscando, por favor escriba a partner@catgen.com .

Imagen Digital

Tener imágenes digitales adecuadas y llamativas es el primer paso para ganar una presencia en internet. Para obtener ayuda en esto, consulte los recursos web que están a continuación:

Conceptos de creación de Imágenes Digitales
 Tomando Imágenes Digitales 

Usando el software CatGen para crear su sitio web

Léa el Tutorial o Tome un Tour .
Creando sitios web más llamativos

El software de CatGen viene con un juego de plantillas básicas de sitios web. Para cada plantilla usted puede controlar la imagen de fondo, fuente y colores, y el logotipo de su empresa. Véase los tópicos Escogiendo plantilla y estilo y Cargar Estilo para aprender a aplicar una plantilla pre-fabricada en su sitio web. Véase el tópico de Tutorial Avanzado Introducción a las plantillas CatGen para aprender a acomodar sus plantillas.

Si usted desea un sitio web diseñado profesionalmente, nuestros socios en otros países pueden hacerlo por un honorario razonable. Para más información escriba a partner@catgen.com .

Aceptando el pago, y abriendo una cuenta de comercio para procesar tarjetas de crédito

Pruebe este artículo: El Laberinto de Cuentas de Comercio. Para finales del 2002 CatGen.com también intenta ofrecer servicios de pago para sus miembros, eliminando la necesidad de obtener una cuenta de comercio.

También puede abrir una cuenta de PayPal para aceptar pagos con su carro de compras CatGen.
Comercializando sus productos y su sitio 

Todas los sitios web pagados de CatGen entran automáticamente en el índice de los mayores motores de búsqueda, a pesar de que este proceso puede tomar varios meses. Para asegurar que sus productos aparezcan en motores de búsqueda usted necesita colocar los meta tags apropiados en sus páginas web. Véase el tópico del Tutorial Avanzado Poniendo Indice a su sitio web para más información.
Para finales de Marzo del, 2002, CatGen le permitirá transferir automáticamente la información de su producto a un eBay. No habrá recargo por este servicio (excepto por los costos normales de eBay), y esto le permitirá con solo unos pocos clicks evitar alrededor de 10 minutos de ingreso de datos.  
Empacando y enviando su producto

El Carro de Compras junto con su cuenta de vendedor CatGen le da acceso directo a calculadores de envíos de USPS, UPS y Federal Express, y le permiten cargar tarifas de embalaje y envío de distintas maneras. Usted maneja sus órdenes a través de su  Panel de Control de Vendedor  en el sitio CatGen.com.
Para finales del 2002 CatGen.com también ofrecerá soluciones de pagos y envíos desde países tercermundistas hacia Europa y Norte América. Este ambicioso proyecto utilizará la agregación de envío para bajar el costo de productos enviados digamos desde el Ecuador a los Estado Unidos a aproximadamente $2.00 el kilo, con un cargo mínimo de $5.00. 

Sincronización de Base de Datos



El programa CatGen guarda toda la información que comprende su sitio web (productos y páginas) en una base de datos en su computador local. Esta base de datos reside en su directorio de programa CatGen (normalmente “C:\program files\catgen”) y es llamado “xxx,mdb”, donde “xxx” es su código de empresa. Cuando usted publica su sitio web, esta información es transferida a CatGen.com. Así que mientras mantenga a su sitio web actualizado, su información se mantendrá guardada en catgen.com y usted podrá recuperarla de su host aún si su computador se destruye. Para más información véase el tópico de ayuda Publicar catálogo web, Cuadro de diálogo Opciones avanzadas  

El software de CatGen le muestra el estado de sincronización de cada una de sus páginas y productos por color. Si un producto o página web está pintada de rojo, esto significa que este producto ha cambiado en su computador local y automáticamente será enviado al host la próxima vez que usted publique su catálogo web .

A pesar de que su base de datos es guardada en el host y puede ser recuperada en caso de problemas, de todas maneras es una buena idea hacer respaldos frequentes de su base de datos.  
Programa de Precios Múltiples 



El programa de precios múltiples es una característica utilizada por sitios B2B. Usted puede querer  usar el programa de precios múltiples en las siguientes circunstancias:

Usted desea tener precios de clientela para vendedores mayoristas registrados en el sistema CatGen, o par compradores registrados que usted apruebe.   

Usted desea mostrar un precio que incluya el envío a un destino escogido, por ejemplo FOB Miami y FOB Londres. 

Usted desea poner precios de clientela para un vendedor individual.

Puede hacer todo esto asignando precios desde diferentes programas de precios hacia sus productos.  Cada uno de sus productos (u Opciones de Productos individuales o SKUs de Productos) puede tener por lo menos cuantos precios como Programas de Precios tiene usted. Adicionalmente, usted puede crear precios de descuento por volumen de compras para sus productos. Su catálogo CsatGen calculará el precio más bajo posible al que un comprador puede acceder bajo las Reglas de Visibilidad de Precios descritas abajo.

El proceso para prácticamente ingresar sus precios es descrito en el Formulario de Precios de Productos.

Reglas de Visibilidad de Precios
El precio al que un comprador puede acceder depende de los siguientes factores:

En qué Estatus de Visibilidad se ha acordado el programa de precios. Los Programas de precios pueden tener Estatus acordados de Visibilidad de Público, Visibles a Compradores Registrados, Visibles a Compradores Registrados y Aprobados, o sino pueden ser Escondidos. Esto está descrito más adelante en el formulario de Programa de Precios.

Si un comprador que está buscando en su sitio web a registrado un comprador mayorista en el sistema CatGen.

En el caso de un programa de precio Visible a Compradores Registrados y Aprobados, en el cual el comprador ha requerido específicamente acceso a sus programas de precios en un email a usted, y si usted le ha aprobado a que tenga visibilidad a ese programa de precios.

Programa Calculado de Precios
En un lanzamiento futuro de CatGen, será posible especificar Programas Calculados de Precios. Esto le permitirá, por ejemplo, asignar fácilmente un 10% de descuento en todos sus productos para un comprador o compradores de su elección.

Dispositivo de Adquisición de Imagen 



Una imagen digital puede adquirirse con: 

Cámaras digitales  

Scanners 

Dispositivos de captura de videos  

Cámara Digital 

Las cámaras tradicionales graban imágenes en película. Luego, la película es procesada y se hace impresiones. 

Por otro lado, la cámara digital, graba imagines electrónicamente en un dispositivo de acoplamiento de carga (CCD), el cual captura la luz reflejada de la escena original y la guarda como pixels rojos, verdes y azules. Las fotos están listas para ser revisadas, editadas o compartidas instantáneamente en el panel LCD, transferido a su computador o visto en un televisor.   

La cámara digital y el web son la combinación perfecta. Tome sus fotos, enchufe la cámara a su computador, y sus fotos son descargadas y listas para ser usadas. Sin rollos que revelar, ni fotos de papel que escanear. Y las cámaras vienen con un software básico que le permite modificar las imágenes. 

Así como una cámara tradicional de apuntar y disparar, hay los implementos familiares para lentes de zoom, flash, reloj propio y cierre. Adicionalmente, las cámaras digitales frecuentemente tiene un panel LCD para ver previamente y ver inmediatamente las imágenes. También hay controles para balance en blanco, resolución y compresión así como un menú que le permite tomar ventaja de un número de capacidades digitales.  

Mientras usted captura sus fotos con una cámara digital, ellas serán guardadas en un medio de almacenamiento removible, reusable, como un floppy disk, Compact Flash cards o Smart Media. Piense en éstos como un rollo sin fin de “película digital”. Para empezar a poner a sus fotos a trabajar, primero debe transferir sus fotos a su computador. La mayoría de las cámaras digitales ofrecen un sinnúmero de maneras de transferir imágenes a su computador. 

Serial – conectando su cámara al puerto serial en su computador utilizando el cable especial previsto usted puede transferir imágenes directamente de la cámara al computador.

Lector de Tarjetas –un dispositivo periférico del tamaño de un mouse que acepta Tarjetas compatibles de Fotos Kodak compatibles y provee una transferencia de imagen a alta velocidad.  
PCMCIA – un dispositivo auxiliar de almacenamiento de datos e imagines delgada y del tamaño de una tarjeta de crédito, que encaja en la ranura PCMCIA de su computador (con adaptador) o un lector especializado de tarjetas para transferencia directa del disco.

Infrarrojo – la opción inalámbrica para transferir imágenes que utiliza un rayo infrarrojo para transferir imágenes o datos entre la cámara y el computador. Requiere un puerto infrarrojo tanto en la cámara como en el computador para operar.

USB – una conección Bus Universal Serial le permite transferir datos a una velocidad de hasta 10 veces más rápida que los cables seriales tradicionales. El diseño delgado del alambre lo hace fácil de conectar y hasta se lo puede “enchufar en caliente”.  

Una vez que transfiera imagines a su computador, usted está listo para insertar sus imágenes a las páginas web.

Scanners de Imagen

Las cámaras de imagen capturan imágenes de imágenes difíciles de copiar existentes o de dibujos de los formatos digitales compatibles con computador. Hay diferentes tipos de scanners que sirven para diferentes propósitos. 

Cámara de Video

La cámara de video graba fotos del mundo que nos rodea. Nuestro sistema visual recibe ondas de luz reflejadas del medioambiente. Una cámara de video después de recibir ondas de luz reflejadas del medioambiente las convierte en señales eléctricas.
Conceptos de Imagen Digital



Una imagen digital es un archivo de computador o una representación de su objeto, historia, o escena, en forma digital o legible para el computador. Puede ser exhibido en una página web o utilizado para imprimir catálogos de papel.

Hay dos formas de obtener un archivo de imagen digital. La primera es por conversión de  sus imagines “análogas”, como slides de 35mm, transparencias o arte reflexivo, a imágenes digitales con un scanner. La segunda es capturando directamente el objeto o escena a una forma digital por medio de una cámara digital o un dispositivo de captura de video. Estos dispositivos crean un archivo de computador que usted puede cargar directamente al software de CatGen sin ninguna modificación o procesamiento.   
Las imagines digitales también pueden ser guardadas en el disco duro de un computador u otro medio electrónico. Pueden ser transferidas de un computador a otro o enviadas electrónicamente. Sus imágenes de productos CatGen son guardadas internamente en su base de datos de su computador, y cuando usted publique su base de datos, son transmitidas electrónicamente al servidor CatGen.  
Introducción a la Imagen Digital 



Crear imagines digitales de calidad de sus productos es la clave para comercializarlos exitosamente en el Web. 

Véase los tópicos de abajo para más información.  

Conceptos de Imagen Digital 

Dispositivos de Adquisición de Imagen 
Qué es un "Catálogo de Catálogos" (CoC)



El sistema de  "Catálogo de Catálogos" le permite incluir los productos de un grupo de vendedores que usted defina en su propio Catálogo de Catálogos. Usted puede ganar dinero revendiendo cuentas CatGen y dependiendo del arreglo que tenga con sus miembros, también puede ganar comisiones de ventas de productos que son vendidos a través de su sitio de Catálogo de Catálogos.

El "Catálogo de Catálogos" (CoC) es una herramienta poderos para crear el corazón de un portal agregando vendedores múltiples de CatGen a su propio catálogo master de búsqueda. Es valioso especialmente para sistemas de negocios con cientos y hasta miles de miembros, como cámaras de comercio, asociaciones industriales, u organizaciones de exportadores. El CoC permite al sistema de negocios establecer un nuevo flujo de renta mientras ofrece un servicio a sus miembros. La proposición sobresaliente de valor es la siguiente:

Un sistema de negocios puede inscribirse para una cuenta de $50/mo CoC y luego ofrecer a cada uno de sus miembros una cuenta gratuita de 15 páginas que puede agregar a un portal de búsqueda CoC. Mientras los miembros suben su categoría a cuentas pagadas, el dueño de CoC recibirá una comisión del 30% del valor de hosting (por dos años) pagados por sus miembros.

 

Recursos Web

Sitio CoC de muestra


Siguiente tópico: Trabajando con su CoC, 
Trabajando con su CoC


Crear y trabajar con un Catálogo de Catálogos es tan fácil como crear un sitio CatGen regular. 

La forma más fácil de entender un CoC es como una lista de vendedores. Usted controla los vendedores (y por lo tanto los productos) que aparecen en su sitio CoC. 

Usted mantiene su catálogo CoC de la misma manera que mantiene una catálogo regular de vendedor, usted crea su página de inicio y otras páginas de información, usted escoge un estilo, etc. Sin embargo, en vez de crear Productos en el Formulario de Todos los Productos usted agrega Vendedores en el  Formulario de Todos los Vendedores.  En lugar de crear una Línea de Producto usted crea una Página de Lista de vendedores, y en vez de arrastrar y colocar Productos en Líneas de Productos usted arrastra y coloca Vendedores en Páginas de Lista de Vendedores. Realmente es simple.
Creando un nuevo CoC

Inscríbase para una cuenta CoC en CatGen.com. Este es el mismo proceso que para registrarse para una cuenta regular de vendedor, Pero asegúrese de que escoja la opción Catálogo de Catálogos en el formulario de registro.

Abra el CatGen, seleccione File > New company, seleccione la opción Catálogo de Catálogos, e ingrese su código de vendedor y clave.

Agregando Vendedores a su CoC

Véase Formulario de Todos los Vendedores.

Publique su Catálogo

Usted publica su catálogo CoC exactamente en la misma manera que usted publica su catálogo normal de CatGen.
Introducción a las Plantillas CatGen 



El CatGen utiliza plantillas XSLT (eXtensible Stylesheet Transformation Language), adicionalmente a las  CSS stylesheets, para controlar tanto la apariencia (colores, fuentes, fondos) y formato de su sitio web. Si usted ha abierto una cuenta pagada en CatGen.com, usted puede ganar un control completo de la apariencia de su sitio web cambiando el código en sus plantillas u hojas de estilo. Nota: si usted tiene una cuenta gratuita, de todos modos usted puede cambiar sus plantillas y hojas de estilo en el software de CatGen, pero no tendrá ningún efecto en su sitio web, ya que solo hay una plantilla disponible para cuentas gratuitas.

El proceso para cambiar el código en su plantilla u hojas de estilo es diferente del proceso para Escoger una Plantilla y Estilo. En el último caso, usted escoge de una variedad de plantillas y estilos pre-definidos, creados por el equipo de creación de CatGen. En el primer caso usted prácticamente modifica el código en la plantilla para crear algún efecto especial en su formato.

Usted puede querer cambiar sus plantillas y hojas de estilo por varias razones:

Usted desea cambiar ciertos bloques de texto que están colocados en el sitio web (por ejemplo usted puede querer cambiar el texto predeterminado “Buscar” en su plantilla Master a “Buscar mis Productos”) 

Usted puede querer agregar arreglos de color o fuente que aún no han sido definidos.

Usted puede desear agregar animaciones Javascript a su sitio web, por ejemplo para crear efectos de rodaje.

Usted puede ser un programador que desea crear sitios web muy sofisticados (por ejemplo el sitio peoplink.org es creado con CatGen).

Asignando una Plantilla a una página web

Usted asigna plantillas CatGen a sus páginas de la pestaña de Propiedades de Página de cada una de las páginas web:
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Usted escoge plantillas para cada página en los campos de Plantilla Master y El cuerpo de la Plantilla 
La Plantilla Master define la apariencia general de su página (bandera superior, barras de navegación, colores y fuentes). 

La Plantilla Cuerpo define la apariencia del cuerpo de su página (el centro de su página donde aparece la información del producto. No todo tipo de páginas tienen una Plantilla Cuerpo). 

Tipos de plantillas 

Las plantills, así como las páginas, son de diferentes tipos. Todas las páginas tienen una plantilla Master. Las plantillas cuerpo solo están disponibles en cierto tipo de páginas, como a continuación:  

	Tipo(s) de Página 
	Usted puede asignar este tipo de Plantilla Cuerpo a la página....

	[image: image39.bmp] Página de    Inicio

 [image: image40.bmp] Línea de Producto
	Plantilla Cuerpo de Lista de Productos

	[image: image41.bmp] Página de Información
[image: image42.bmp] Página de Historia
	(ninguna. Las páginas de Información y de Historia no tienen una plantilla Cuerpo. La apariencia de estas páginas es definida exclusivamente en la pestaña de Diseño de la página) 

	[image: image43.bmp] Página de Producto
	Plantilla Cuerpo de Detalles de Producto

	[image: image44.bmp] Pagina de Contacto
	Plantilla Cuerpo de Detalles de Vendedor

	[image: image45.bmp] Lista de  Vendedores 
	Plantilla Cuerpo de Lista de Vendedores 


 

El estilo estándar de CatGen solo viene con Una plantilla de cada tipo. Así que este diálogo no es muy significante, ya que solo tendrá una opción de plantilla cuando baja las Plantillas Master o Cuerpo. Sin embargo, es posible crear varias plantillas Master diferentes, o plantillas Cuerpo, y también modificar sus plantillas predeterminadas. Por ejemplo, usted puede querer tener una apariencia diferente para su página de inicio de las otras de su sitio web. Usted puede hacer esto creando una nueva plantilla Master y asignándola  a su página de inicio. Para más información véase el siguiente tópico Modificando sus plantillas.
Modificando sus plantillas 



Usted puede desear modificar sus plantillas y hojas de estilo por varias razones, como lo antes descrito, por ejemplo para cambiar algún texto en todas sus páginas, agregar una imagen, o sino para tomar control completo del contenido y presentación de su sitio web    escribiendo el Código XSLT . 

Usted no tiene que ser un programador XSLT , para hacer cambios radicales a sus plantillas y a la apariencia de su sitio web. Si usted está familiarizado con Macromedia Dreamweaver o Dreamweaver Ultradev, usted puede utilizar Dreamweaver para crear plantillas CatGen y luego importarlas al CatGen. Véase el tópico Introducción a la interface CatGen Deamweaver. 

 

Modificando el esquema de fuente y color de una plantilla Master existente 

Asegúrese de que el Formulario de Plantillas esté visible seleccionando View > Templates.  

La Ventana Plantillas (en el webtree) muestra una lista de sus plantillas XSLT disponibles y hojas de estilo CSS. Haga click en la que usted quiere cambiar, por ejemplo “Master”. La ventana principal le dirá qué tipo de plantilla está en el campo Tipo de Plantilla (en este caso, por supuesto es una Plantilla Master). 
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Plantilla Master:
Nombre / tipo de plantilla / color del cuadro /fondo del cuadro

Usted puede cambiar el esquema de color seleccionando un esquema diferente de color cuando baja.

Usted puede cambiar el esquema de fuente seleccionando uno diferente en el bajando barra de navegación
Obtenga una Vista Previa de su nueva plantilla haciendo click en guardar, y luego viendo previamente cualquiera de sus páginas web en la pestaña Vista Preliminar.

 

Modificando el código (contenido) de una plantilla existente

Seleccione una de sus plantillas como arriba

Haga click en la Pestaña de Fuente. Aparece el código XSLT para las plantillas:
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Código fuente
Usted no tiene que entender el lenguaje XSLT para hacer un cambio, solo necesita saber que una plantilla CatGen está hecha de expresiones html mezcladas con expresiones (de programación) XSLT (y también expresiones Dreamweaver –véase el tópico Plantillas Dreamweaver). Usted puede cambiar cualquier html en la plantilla haciendo clic con el botón derecho, Busque y Remplace el texto que usted quiere cambiar y luego haga click en Guardar. Por ejemplo, si usted quiere guardar el encabezamiento “Buscar” a “Buscar mis Productos”, lo puede hacer con el comando Busque y Remplace. 

Obtenga una Vista Previa como arriba. Un cambio en la plantilla Master afectará a todas sus páginas en su sitio web. 
Creando una nueva plantilla 

Seleccione una plantilla como arriba

Haga click en el botón Nuevo. Después de la confirmación, una copia de la plantilla será hecha 

Cambie el nombre de su nueva plantilla en la pestaña de Propiedades de Página (por ejemplo, llámela “Plantilla Master para página de inicio” si usted está haciendo una plantilla master alterna que solo quiere mostrar en su página de inicio) 

Cambie el código de la plantilla, como arriba 

Haga click en Guardar 

Haga click en cualquier página de su sitio web. La nueva plantilla estará disponible en uno de los barras de navegación, ya sea para la Plantilla Master o Plantilla Cuerpo.  

Modificando una plantilla CSS (hoja de estilo) 

Las hojas de estilo CSS son nombradas algo así como "Color Violeta" o "Fuente Verdana Mediana". Las hojas de estilo de Color y Fuente están asociadas con una plantilla master. Usted puede cambiar sus hojas de estilo o agregar nuevas hojas de estilo de la misma manera en que cambia plantillas.  

Nota: usted necesita ser algo familiar con el lenguaje CSS para hacer esto eficientemente. 

Programación XSLT 



El CatGen está estrechamente integrado con Macromedia Dreamweaver (o Dreamweaver Ultradev). Usted puede crear plantillas muy llamativas exportando una plantilla CatGen hacia una plantilla Dreamweaver, haciendo cambios en Dreamweaver, y luego importándola de regreso al CatGen.   

Exportando una plantilla CatGen a una plantilla Dreamweaver

Seleccione File > Export > Dreamweaver template.  Seleccione la plantilla que usted quiere exportar (normalmente es su plantilla Master) 

Seleccione el directorio de exportación de raíz y haga clic en Ok. CatGen crea una carpeta con las siguientes subcarpetas: 


<root>
    Plantillas:  las plantillas exportadas (normalmente "Master.dwt")
    CSS: las hojas de estilo exportadas necesitadas por las plantillas  
    Imágenes: las imágenes necesarias para la vista previa de una plantilla en  Dreamweaver 

Abra el archivo de plantilla Dreamweaver creado en este proceso (normalmente <root>\Templates\Master.dwt) y haga cualquier cambio necesario, como se describe abajo
Importando la plantilla Dreamweaver de regreso a  CatGen.

Seleccione File > Import > Dreamweaver templates > Master 

Seleccione su plantilla Dreamweaver en el cuadro de diálogo, y haga click en Ok. 

Si esta es la primera vez que usted ha realizado esta función, un cuadro de diálogo aparecerá diciendo que necesita componentes adicionales de software. Si usted hace click en Ok, el programa htmltidy se descargará. El Htmltidy es necesario, porque el archivo .dwt debe cumplir la prueba de html “bien formado” para poder trabajar con CatGen y XSLT. El Htmltidy corregirá los errores normales (principalmente etiquetas html que no se cerraron correctamente, por ejemplo <img src=...> necesita ser <img src=... />, <br> necesita ser <br/> etc).  

La plantilla importada reemplazará su plantilla actual, utilizando ciertas reglas (descritas abajo), y todas las imágenes serán importadas a la base de datos   

Obtenga una Vista Previa de su nueva plantilla visualizando cualquier página de su sitio.

 
Haciendo cambios a su plantilla Dreamweaver 

Una plantilla CatGen Dreamweaver debe tener cierto formato. Esta es la razón por la cual a pesar de que es posible crear plantillas Dreamweaver desde el principio, la forma más fácil es exportar una plantilla master CatGen y modificarla.     

Las plantillas CatGen Dreamweaver trabajan de la misma manera que las Plantillas Dreamweaver normales, con un proceso adicional:

Cada elemento de su sitio que es dinámicamente generado (i.e. generado por código XSLT) es encaminado por secciones 
<!--BeginEditable "<name-of-element>" --> y <!--EndEditable-->. Todo elemento que necesite traducción (como los nombres de las agrupaciones de vínculos en la barra de navegación como “Vínculos” o “Historias Relacionadas” ) también debe estar en una bloque de BeginEditable/EndEditable. 

Usted puede cambiar cualquier elemento  fuera de un bloque <!--BeginEditable--> ... <!--EndEditable-->, incluyendo tablas, imágenes, formateo, etc. También puede cambiar cualquiera de las hojas de estilo. Cualquier elemento cambiado sobrescribirá los archivos originales cuando usted reimporte.

Si usted cambia cualquier elemento dentro de <!--BeginTemplate--> ... <!--EndTemplate-->, recuerde que esa sección reemplazará cualquier código XSLT generado por CatGen. Por ejemplo, normalmente la sección “Buscar “ es generada automáticamente  dentro de la sección:
<!-- #BeginEditable "browse_content" --><!-- #EndEditable --> 

Ciertos elementos de plantilla son requeridos en su hoja de estilo. Estos son prearreglados con el nombre “requerido-”. Si usted remueve estas secciones, usted obtendrá un error o una advertencia. Puede sobrescribir la sección “requerida” con su propio contenido, pero esté alerta de las consecuencias. Por ejemplo usted no debe modificar la sección:
<!-- #BeginEditable "required_body" --><!-- #EndEditable -->, ya que no tendrá sentido tener una plantilla Master sin un cuerpo de página (el contenido dinámico no será generado en ninguna página, resultando ser un sitio web muy aburrido). 

Es una bueno colocar cuanto más se pueda del formateo en la hoja de estilo como sea posible. Por ejemplo, en vez de escribir <td backcolor="#00CCFF"...> escriba <td class=tableContent> o <td class=tableCaption>. Usted debe familiarizarse con las hojas de estilo CatGen.

Esto solo es información básica. Usted está limitado únicamente por su habilidad, creatividad e imaginación para crear nuevas plantillas CatGen. 

Traduciendo contenido XSL  

En un lanzamiento futuro se implementará hojas de estilo de idioma múltiple.   

Introducción a la Interfase CatGen/Dreamweaver 



El CatGen está estrechamente integrado con Macromedia Dreamweaver (o Dreamweaver Ultradev). Usted puede crear plantillas muy llamativas exportando una plantilla CatGen hacia una plantilla Dreamweaver, haciendo cambios en Dreamweaver, y luego importándola de regreso al CatGen.   

Exportando una plantilla CatGen a una plantilla Dreamweaver

Seleccione File > Export > Dreamweaver template.  Seleccione la plantilla que usted quiere exportar (normalmente es su plantilla Master) 

Seleccione el directorio de exportación de raíz y haga clic en Ok. CatGen crea una carpeta con las siguientes subcarpetas: 

<root>
    Plantillas:  las plantillas exportadas (normalmente "Master.dwt")
    CSS: las hojas de estilo exportadas necesitadas por las plantillas 
    Imágenes: las imágenes necesarias para la vista previa de una plantilla en  Dreamweaver 

Abra el archivo de plantilla Dreamweaver creado en este proceso (normalmente <root>\Templates\Master.dwt) y haga cualquier cambio necesario, como se describe abajo
Importando la plantilla Dreamweaver de regreso a  CatGen.

Seleccione File > Import > Dreamweaver templates > Master 

Seleccione su plantilla Dreamweaver en el cuadro de diálogo, y haga click en Ok. 

Si esta es la primera vez que usted ha realizado esta función, un cuadro de diálogo aparecerá diciendo que necesita componentes adicionales de software. Si usted hace click en Ok, el programa htmltidy se descargará. El Htmltidy es necesario, porque el archivo .dwt debe cumplir la prueba de html “bien formado” para poder trabajar con CatGen y XSLT. El Htmltidy corregirá los errores normales (principalmente etiquetas html que no se cerraron correctamente, por ejemplo <img src=...> necesita ser <img src=... />, <br> necesita ser <br/> etc).  

La plantilla importada reemplazará su plantilla actual, utilizando ciertas reglas (descritas abajo), y todas las imágenes serán importadas a la base de datos   

Obtenga una Vista Previa de su nueva plantilla visualizando cualquier página de su sitio.

 

Haciendo cambios a su plantilla Dreamweaver 

Una plantilla CatGen Dreamweaver debe tener cierto formato. Esta es la razón por la cual a pesar de que es posible crear plantillas Dreamweaver desde el principio, la forma más fácil es exportar una plantilla master CatGen y modificarla.     

Las plantillas CatGen Dreamweaver trabajan de la misma manera que las Plantillas Dreamweaver normales, con un proceso adicional:
Cada elemento de su sitio que es dinámicamente generado (i.e. generado por código XSLT) es encaminado por secciones 
<!--BeginEditable "<name-of-element>" --> y <!--EndEditable-->. Todo elemento que necesite traducción (como los nombres de las agrupaciones de vínculos en la barra de navegación como “Vínculos” o “Historias Relacionadas” ) también debe estar en una bloque de BeginEditable/EndEditable. 

Usted puede cambiar cualquier elemento  fuera de un bloque <!--BeginEditable--> ... <!--EndEditable-->, incluyendo tablas, imágenes, formateo, etc. También puede cambiar cualquiera de las hojas de estilo. Cualquier elemento cambiado sobrescribirá los archivos originales cuando usted reimporte.

Si usted cambia cualquier elemento dentro de <!--BeginTemplate--> ... <!--EndTemplate-->, recuerde que esa sección reemplazará cualquier código XSLT generado por CatGen. Por ejemplo, normalmente la sección “Buscar “ es generada automáticamente  dentro de la sección:
<!-- #BeginEditable "browse_content" --><!-- #EndEditable --> 

Ciertos elementos de plantilla son requeridos en su hoja de estilo. Estos son prearreglados con el nombre “requerido-”. Si usted remueve estas secciones, usted obtendrá un error o una advertencia. Puede sobrescribir la sección “requerida” con su propio contenido, pero esté alerta de las consecuencias. Por ejemplo usted no debe modificar la sección:
<!-- #BeginEditable "required_body" --><!-- #EndEditable -->, ya que no tendrá sentido tener una plantilla Master sin un cuerpo de página (el contenido dinámico no será generado en ninguna página, resultando ser un sitio web muy aburrido). 

Es una bueno colocar cuanto más se pueda del formateo en la hoja de estilo como sea posible. Por ejemplo, en vez de escribir <td backcolor="#00CCFF"...> escriba <td class=tableContent> o <td class=tableCaption>. Usted debe familiarizarse con las hojas de estilo CatGen.

Esto solo es información básica. Usted está limitado únicamente por su habilidad, creatividad e imaginación para crear nuevas plantillas CatGen.
 

Como convertir una página web existente en su página de inicio en CatGen

1)Guarde una página web existente en el disco desde el Internet Explorer digamos en c:\temp\webpage.html. Seleccione la opción "Guardar página web, completa”, la cual también guarda las imágenes. 
2)Renombre a la webpage.html en webpage.dwt
3)Abra la página en Dreamweaver y agregue las siguientes secciones: 
3.1) Antes de la etiqueta <html> en el comienzo de la página, inserte las siguientes secciones:
<!-- #BeginEditable "required_xslheader" --> <!-- #EndEditable -->

Advertencia:
No debe haber ninguna otra etiqueta antes de la sección y la etiqueta <html>, pero las etiquetas de comentario están permitidas en cualquier parte de la página. También remueva cualquier etiqueta como la siguiente (son incorrectas en XML y ocasionarán un error durante la transformación XSLT):

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">

3.2) Agregue entre las etiquetas <head> y </head> las secciones:
<!-- #BeginEditable "required_htmlheader" -->
<!-- #EndEditable -->
3.3) Después de la etiqueta <body> agregue:
<!-- #BeginEditable "required_backgroundimage" -->
<!-- #EndEditable -->
<!-- #BeginEditable "body" -->
3.4) Después de la etiqueta </body> agregue: <!-- #EndEditable -->
3.5) Después de la etiqueta </html> agregue:
<!-- #BeginEditable "required_xslfooter" --> 
<!-- #EndEditable -->
4)En catgen, seleccione la plantilla Master mínima y haga click con el botón derecho en "Nuevo Desde Actual". Renombre la nueva plantilla en  "Plantilla Master Para Página de Inicio". 

5)  Seleccione File > Import > Dreamweaver Template > Master > Master Template for Home Page, y seleccione "webpage.dwt". 

6)Seleccione Home page, y escoja "Master template for Home page " en la lista drop-down.

Hojas de Estilo de Idioma Múltiple
Las cuerdas utilizadas en la hoja de estilo (“vínculos”, “buscar”) pueden ser traducidas. Véase la plantilla llamada "Recursos" (View > Templates)  

Sitios web de Idioma Múltiple 



Usted puede crear su sitio web hasta en dos idiomas (y pronto tres) simultáneamente. Puede hacerlo escogiendo uno o más idiomas adicionales en el formulario Configuración de Empresa. 

El efecto de agregar un Segundo idioma a su sitio web puede ser visto navegando en las páginas web de la Empresa de Demostración de CatGen (www.catgen.com/demo).  Esencialmente, cada página tiene un vínculo a la página traducida. Por ejemplo intente haciendo click en el vínculo “Español” en cualquier página de la empresa de Demostración de CatGen.   

Aún que no es requerido, se recomienda altamente que usted determine el Inglés como primer idioma de su sitio web. Esto asegurará que los compradores de Norteamérica y Europa puedan ver sus productos.

Si usted crea un sitio web de idioma múltiple, aparecerán pestañas adicionales encada uno de sus formularios, donde usted deberá traducir el contenido de sus sitio web. Al menos en las siguientes ubicaciones aparecerán pestañas adicionales de idioma: 

En la descripción de su empresa en la Pestaña de Empresa 

En la pestaña de Propiedades de Página de cada una de sus páginas web (guarda el nombre de su página web en el segundo idioma)

En el Nombre y Descripción de sus Productos .

Cada una de sus páginas de Información tendrán pestañas de idioma dentro de la Pestaña de Diseño .

En los nombres de sus Programas de Precios. 

Crear un sitio web de idioma múltiple involucra mucho más de lo que lo hace un sitio de un solo idioma, ya que usted necesitará mantener toda esa información exacta y al día.   

Indexando a su sitio web
  

El medio más efectivo de hacer que su sitio web tenga máxima visibilidad en los motores de búsqueda es la colocación correcta de sus “meta tags” en su sitio web. Estas son palabras u oraciones que el software de CatGen colocará en sus páginas web y que son leídas por los mayores motores de búsqueda mientras (automáticamente) exploran su catálogo catgen. Sin embargo, usted debe definir sus meta tags en el software CatGen en el Formulario de Propiedades de Página en los campos Keyword Meta Tags y Description Meta Tags.

Favor note que todos los catálogos CatGen pagados son automáticamente indexados por los mayores motores de búsqueda. Este proceso sin embargo puede tomar varios meses. Usted puede acelerar este proceso utilizando los servicios de sometimiento de cualquiera de los motores de búsqueda pagados o gratuitos, los cuales puede encontrar en una búsqueda en el web para un sometimiento en un motor de Búsqueda. 

Después de que ha tenido su catálogo CatGen por al menos tres meses, usted puede ir a Yahoo o su motor de búsqueda favorito y tratar de encontrar a su empresa por el nombre. Si no está ahí, usted puede escribir a support@catgen.com.
 

Interrogantes SQL para Generación de Línea de Producto  



Usted puede generar el contenido de una página de Línea de Producto (i.e. Productos que están incluidos en su línea de producto) escribiendo una interrogante SQL que correrá en su base de datos. Esta es una característica muy útil si tiene un catálogo grande y desea crear automáticamente líneas de producto  con ciertas características – por ejemplo- un cierto rango de precios, manufacturador, nombre de código, etc. 

Nota: Esta es una característica avanzada que requiere alguna familiaridad con SQL, o sino podrá usar las interrogantes de ejemplo a continuación.   
Utilizando una interrogante SQL para generar una línea de producto 

Abra la Página de Línea de Producto haciendo click en el árbol web, y seleccione la pestaña de Propiedades de Página.


[image: image48.png]Page Prpeties | Links | Desgn| Sutce Coe| Fiovien |

PagelD. 0 Spanish |
Name E—
KepworgMetaTags |

DescipionMetaToss [

isible. i

Master Template Master -
Bod Template Product List <

Password Protected? |
Generale product st | SELECT * FROM Products

from an SOL stalement ’—J

== s





Marque el cuadro Generar lista de producto desde un informe SQL  

Ingrese una Interrogante SQL en el cuadro Seleccionar * DESDE Producto DONDE... (véase abajo par interrogantes de muestra) 

Haga click en Generar Ahora.  Su línea de producto estará poblada por los productos que cumplen con la condición de Interrogante SQL. 

Algunas Interrogantes SQL de muestra

	Utilice esta Interrogante... 
	Para obtener este resultado... 

	Código de producto como "F%"
	Productos donde el código de producto empieza con la letra  "F"

	Largo de descripción como "%wool%"
	Productos que contienen “lana” en la descripción del producto

	precio < 1
	Productos menores a $1


 

Interrogantes SQL Avanzadas

Debido a la estructura interna de la base de datos de su empresa, mezclar interrogantes que seleccionan en opciones de precios con interrogantes que seleccionan en otras opciones de producto es un poco riesgoso. Sin embargo, usted puede hacer cualquier cosa virtualmente con CatGen si usted sabe lo que hace. Por ejemplo intente seguir la interrogante para conseguir productos de lana que cuesten entre 1 y 2 dólares:
Seleccione distinct t1.productcode from productSKUPrices t1, products t2 where t1.productcode=t2.productcode and t1.price>1 and t1.price<2 and t2.descriptionlong like '%wool%'
Abriendo una Empresa 



El programa CatGen guarda toda la información que comprende su sitio web (productos y páginas) en una base de datos en su computador local. Cuando usted publica su sitio web, esta información es transferida a CatGen.com. Así que mientras mantenga a su sitio web actualizado, su información se mantendrá guardada en catgen.com y usted podrá recuperarla de su host aún si su computador se destruye. Para más información véase el tópico de ayuda Publicar catálogo web, Cuadro de diálogo Opciones avanzadas y también Sincronización de Base de Datos en el Tutorial Avanzado.

Cuando usted inicia el CatGen por primera vez normalmente obtendrá una pestaña de Bienvenida, donde tendrá la opción de abrir una base de datos de una empresa existente o crear una nueva. Si usted previamente Registró nuevo código de empresa en CatGen.com, obtendrá Crear nueva empresa de la pestaña de registro web la cual está diseñada para simplificar el proceso de crear una nueva empresa.
Abriendo la base de datos de una empresa existente

1. Cuando inicia el CatGen, normalmente aparece la pestaña de Bienvenida.
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En la pestaña de Bienvenida, usted tiene la opción de Abrir una base de datos de una empresa existente o crear una base de datos de una empresa nueva.  Si usted aún no ha creado la base de datos de su empresa, o si la pestaña de Crear nueva empresa del registro web aparece, vea el tópico de ayuda Crear Nueva Empresa.

2. Usted puede tener el mismo efecto con el File > Open Company. Después de escoger de una lista de empresas, el cuadro de diálogo de Login aparece:
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3. Ingrese su clave en el campo de Clave.

Esta debe ser la clave que usted escribió cuando creó la base de datos de la empresa.

4. Haga click en  Aceptar. Ahora usted puede empezar a trabajar con su catálogo web 
 Nueva Empresa



Este comando crea una nueva base de datos de empresa vacía en su computador. 

Si usted está abriendo el programa CatGen inmediatamente después de registrar un nuevo código de empresa en CatGen.com, normalmente obtendrá la pestaña de Crear nueva empresa del registro web, descrita abajo.  

Creando una nueva base de datos de empresa

1. Haga click en  File > New Company. El cuadro de diálogo aparece:
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2. Seleccione una de las opciones de Catálogo o Catálogo de Catálogos.

Escoja la opción de Catálogo si desea crear un catálogo web par una solo empresa. Escoja la opción de Catálogo de Catálogos para crear un Catálogo de Catálogos (un sitio que agrega productos de otros catálogos de vendedores). Para más detalles véase Trabajando con un Catálogo de Catálogos.

3. Ingrese el Código de la Empresa en el campo de Código de Empresa.

Su código de empresa sirve como identificación en el servidor CatGen. Este código debe ser el mismo que usted escribió cuando registró la empresa con CatGen. Véase el tópico de ayuda Registre Su Empresa si aún no ha registrado su empresa con CatGen.

4. Ingrese el nombre de su empresa en el Campo Nombre de Empresa.

5. Escoja una clave e ingrésela en el campo Clave.

Usted debe recordar su clave y debe ser difícil para otros descifrarlo. Su clave protege su base de datos y catálogo Web.

6. Confirme su clave rescribiéndola en el campo Confirmar Clave.

7. Haga click en el botón Crear.

El cuadro de diálogo de Escoger Plantilla y Estilo aparece, para más información ver Escogiendo plantilla y estilo. 

8. Haga click en OK.

La base de datos de su empresa está creada y ahora puede empezar a trabajar con el catálogo web de su empresa. Para aprender más acerca de trabajar con el catálogo web, haga click en el formulario Trabajando con la página web.

Creando una nueva empresa desde un registro web 
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La pestaaña de Nueva Empresa Desde Registro Web en el formulario de Login simplificará el proceso de crear una nueva base de datos de empresa si usted acaba de registrar un Nuevo código de empresa en CatGen.com. En el formulario usted puede ver el Código de Empresa y el Nombre de la Empresa que usted especificó mientras registraba la empresa en CatGen.com, y solo tiene que ingresar la clave de la empresa y hacer clic en el botón de crear para crear una nueva base de datos para la empresa.

Nueva Empresa desde el Host
 

Este comando es similar al comando Nueva Empresa, en el cual crea una nueva base de datos vacía para la empresa en su computador, sin embargo restablece la información de un sitio web de una empresa existente en catgen.com. 

Ejecutar este comando es lo mismo que crear una nueva base de datos de una empresa con el comando Nueva Empresa, y luego utilizando el comando  Crear/Actualizar catálogo web con el comando Opciones Avanzadas Copie la base de datos a una base de datos local.

Creando una nueva base de datos de empresa local de un vendedor existente de catgen.com

1. Haga click en File > New Company From Host.

El cuadro de diálogo de Login aparece con la pestaña de Nueva Empresa Desde el Host.
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2. Ingrese el Código de Empresa utilizado para el sitio web de la empresa en CatGen.com. 

3. Ingrese la clave y rescriba nuevamente la clave en el campo Confirmar Clave. 

4. Haga click en el botón Crear para crear la base de datos para la empresa en su computador. 

Cerrar la Empresa 



La opción de Cerrar la empresa es utilizada para cerrar la base de datos de la empresa en la que está trabajando actualmente. 

1. Haga click en File > Close Company. En el cuadro de mensaje que aparece confirme si desea terminar la sesión actual de base de datos.

2. Haga click en el botón Si  para cerrar la base de datos. 

Borrar la Empresa



La opción de Suprimir Empresa borra la base de datos de la empresa que está actualmente abierta desde su computador. La información en la base de datos no puede ser recuperada una vez que se suprime la base de datos. Para suprimir la base de datos:

1. Haga click en File > Delete Company. En el cuadro de diálogo que aparece confirme si desea suprimir la base de datos actual.

2. Haga click en Si para suprimir la base de datos, o haga click en No para continuar la sesión.

Cambie el Código de la Empresa 


Esta función es utilizada para cambiar el Código de la Empresa de su base de datos CatGen. Usted normalmente hace esto después de registrar un nuevo código de empresa en CatGen.com (uno que le guste más). Después de republicar su sitio web, todos sus productos son transferidos al sitio nuevo. 

Cómo cambiar su código de empresa 

1. Abra la base de datos de la empresa de la cual desee cambiar el Código de Empresa.

2. Haga click File > Change Company Code.

El diálogo de Cambiar Código de Empresa aparece.
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3. Escriba el Nuevo Código de Empresa en el campo otorgado.

El código de la empresa puede tener de 4 a 20 letras o números (A-Z 0 –9) y debe ser único. Escoja su código de empresa con cuidado, ya que será parte de su URL para su página de inicio.

4. Haga click en Aceptar.

Un cuadro de mensaje aparece indicando que el Código de la Empresa ha sido exitosamente cambiado.

Actualización de Software


La opción de Actualización de Software es utilizada para descargar actualizaciones del software CatGen, Estilos de base de datos y archivo de ayuda del servidor de CatGen. Usted debe chequear las nuevas actualizaciones periódicamente, ya que contienen mejoras para el Software y nuevas características. El descargar actualizaciones no dañará la base de datos existente de sus empresa.

Descargar actualizaciones de software:

1. Conéctese al Internet.

2. Haga click en File > Software Update. 

Un cuadro de diálogo de Actualización de Software muestra el progreso de la actualización mientras el servidor CatGen es chequeado para nuevas actualizaciones comparando la versión de CatGen en de su computador con la versión actual enlistada en el servidor. Para ver qué versión del Software CatGen usted está corriendo, haga click en Help > About.
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3. Si la versión de CatGen que usted está corriendo es una antigua, una cuadro de mensaje es mostrado preguntando, Desea actualizar el software? Haga click en SI para actualizar el software CatGen en su máquina o haga click en No para cancelar la actualización.

Si usted hace click en Si, la nueva versión del Software se descarga y el progreso del descargue es mostrado en un cuadro de diálogo de Actualización de Software.

4. Cuando se completa el descargue aparece un cuadro de mensaje con el mensaje Actualización cargada exitosamente. CatGen empezará a registrar la actualización. Continuar? Haga click en Si para completar la actualización.  
Cargar estilo desde Base de Datos Local 



Este comando es utilizado para cambiar el Estilo o Plantillas (formato o presentación) utilizado en su sitio web catgen.  Todas las páginas de su sitio web serán actualizadas automáticamente por este procedimiento. Para más información vea el tópico Introducción a plantillas CatGen.

Usted puede cambiar el estilo o apariencia de su sitio web en cualquier momento. El programa CatGen lleva un inventario de estilo disponibles (incluyendo variedad de imágenes de fondo, fuente y color) localmente. En un futuro, estará disponible una variedad mayor de estilos de sitios web del host, para detalles véase el tópico Cargar Estilo desde Base de Datos Remota.

Cambiando el estilo de su sitio web 

1. Haga click en File > Load Style >  Load Style From Local Database.

2. El cuadro de diálogo de Escoja Estilo y Esquema de Color es mostrado.
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3. Seleccione un Estilo de la lista de estilo disponibles. 

4. Seleccione una imagen de Fondo de la lista, si lo desea. 

5. Seleccione un Esquema de Color de la lista. 

6. Seleccione una Fuente de la lista.  

7. La ventana de preview mostrará la apariencia de su sito web. Usted puede escoger cualquier variación de Estilo, imagen de Fondo, esquema de color o fuente para obtener un formato llamativo. También puede cambiar entre las diversas pestañas de la ventana de Vista Previa de Estilo para ver la apariencia de una página normal, una página de línea de producto, y una página de producto.    
Nota: también puede hacer que un miembro del equipo de creación de CatGen cree un estilo a gusto para usted, para detalles véase http://catgen.com/EN/development partners.html. 

8. Haga click en Aceptar. 

9. Si usted está reemplazando el estilo de su sitio web actual con otro, obtendrá un diálogo preguntando qué plantilla quiere reemplazar. Usted normalmente escogerá el valor predeterminado Sobrescribir Todas las Plantillas. Esto no ocasionará ningún daño, ya que usted no ha modificado ninguna de sus plantillas.
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10. Sus páginas se reabrirán con el Nuevo estilo que ha escogido.

11. Usted debe republicar su sitio web, por supuesto, para que el nuevo estilo haga efecto en su sitio web. 

Cargar estilo desde Base de Datos Remota



Esta característica será implementada en un lanzamiento futuro del software CatGen. 

Importar Opciones



Usted puede utiliza la opción Importar para importar productos, historias o plantillas de otros archivos o base de datos. Cuando usted selecciona la opción Importar en el Archivo menú un submenú es mostrado con las opciones: 

Importar Producto: Esta opción puede ser utilizada para importar productos de otros catálogos de productos a su catálogo web. Note que esto es para importar productos de un catálogo que no sea de catgen. La forma más fácil de importar Productos de otros sitios web de catgen a su catálogo es usar el comando Importar de otro vendedor en el Formulario de Producots. 

Importar Historia: Utilizado para importar páginas web existentes (en formato html) a su catálogo web. 

Importar plantillas Dreamweaver: Utilizado para crear estilos nuevos de catgen desde plantillas Dreamweaver. 

Importar Productos



Este comando importa productos de otra fuente a su catálogo catgen. Es utilizado para transferir un catálogo de productos que usted tenga guardado en otro formato, a su sitio web.  

Primero debe preparar una base de datos de importación de Acceso Microsoft y las imágenes que desea importar.     

Importando productos de otra fuente a su base de datos catgen 

1. Primero, prepare la base de datos de importación. Debe ser una base de datos de Acceso MS en el mismo formato que la que puede descargar desde CatGen.com.  Favor note lo siguiente:

· Su base de datos de importación (Import-test.mdb) debe tener una solo tabla llamada Productos.
· Cualquier nombre de columna en su tabla de Productos que tenga el mismo nombre que las columnas en la tabla de Productos CatGen, será importado. Usted deberá abrir su base de datos de la empresa catgen en el Acceso MS para ver los nombres de columna disponibles.

· Para importar precios, utilice el nombre de columna “Precio (Detal)” o “Precio (Por Mayor)” , donde “Detal” o “Por Mayor” son nombres de su Programa de Precios. Usted no debe tener ningún signo de $ o caracter que no sea numérico en esta columna.

· CatGen automáticamente buscará imágenes en su directorio de importaciones con nombres como “xxx.jpg” (donde “xxx” es su código de producto). Automáticamente le dimensiona esta imagen para crear y encajar una imagen de tamaño de uña, de acuerdo al montaje de su formulario de  Configuración de Empresa. 

· Alternativamente, usted puede especificar el nombre de sus archivos de imagen (imágenes de tamaño completo, y del tamaño de uña) en las columnas Imagen Grande, Imagen Mediana e Imagen Pequeña en su base de datos de importación.

2. Seleccione File > Import > Products.

3. Seleccione su archivo de importación de Acceso MS. 

4. El cuadro de diálogo Importar Productos es exhibido, el cual muestra la lista de campos los cuales están incluidos para cada producto importado. También puede seleccionar unidades para medir el peso y dimensión de los productos. 
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Propiedades de Importación: 
Listas de Campos que se pueden importar
 / Peso / Dimensiones

5. Usted verá una lista de campos que combinan entre su base de datos de importación y su base de datos de la empresa catgen. Estos, y solo estos campos serán importados.

6. Si usted está importando cualquier columna de dimensión o peso, tendrá que ingresar la unidad de dimensión o de peso.

7. Haga click en Importar. Sus productos deben hacerse visibles en el Formulario de Productos . 

8. Usted debe crear sus líneas de producto y asignar sus productos a líneas de producto arrastrando y colocando desde los Productos hacia el árbol web.   

Importar Historias



Este comando importará cualquier página html existente (incluyendo referencias de imagen) a su base de datos de la empresa y creará una página de Historia.  

Importando una página html existente como una historia 

1. Primero, cree la página que desea en un editor externo htmal, o sino guarde cualquier página web en su disco duro. Usted puede encontrar conveniente utilizar el comando de Internet Explorer File > Save As (página web, completa). Esto guarda la página html y todas las referencias de imagen.

2. Haga click en File > Import > Story.

3. Ahora sellecione el archivo HTML para la página que desea importar.  

4. El cuadro de diálogo de Importar Historia es exhibido el cual muestra el camino de los archivos para las historias que fueron importadas.

5. Haga click en Cerrar.  

6. Usted puede obtener una vista previa de su historia importada en el Formulario de Historias.

Importar Plantillas Dreamweaver 



Esto se utiliza para crear nuevos estilos CatGen desde plantillas Dreamweaver. Este es un tópico avanzado cubierto en Introducción a plantillas  CatGen/Dreamweaver .

 

Opción Exportar



El seleccionar la opción Exportar del archivo menú muestra un submenú con las opciones:

Productos: Utilice esta opción para exportar los datos acerca de los productos en la base de datos y las imágenes de estos productos a cualquier carpeta.

Plantillas: Utilice esta opción para exportar plantillas XSLT (eXtensible Stylesheet Transformation Language), hojas de estilo CSS e imágenes asociadas a una carpeta. Esto puede ser hecho para modificar las plantillas.

Plantillas Dreamweaver: Use esta opción para exportar una plantilla CatGen a una plantilla  Dreamweaver. Esto puede hacerse para realizar cambios en Dreaamweaver, y luego importarlo de regreso a CatGen.

Exportar Productos



Si usted elige exportar productos todos los datos acerca de cada producto en el catálogo son exportados a un archivo de texto delimitado por una pestaña en la carpeta que usted escoja. También las imagines del producto son exportadas a la carpeta seleccionada.

1. Haga click en File > Export > Products.

2. Seleccione una carpeta a la cual se exportará los datos y luego haga click en Aceptar.

El resultado de la exportación es mostrado en un cuadro de diálogo.

[image: image59.png]¢ Export [-To[x]
e 1 Expon |

Export Product 0007
Evport Product IMPITA
Evport Product XX0001
Evport Product XX0003
Evport Product XX0005
Evport Product XX0008
Evport Product XX-005
Evport Product X009

8 prodcts and 0 images have been exported
o c\program flestcaigenibackuph




 Resultados de Exportación
3. Haga click en Cerrar para completar la operación de exportación.

Exportar Plantillas



El CatGen utiliza plantillas XSLT (eXtensible Stylesheet Transformation Language), adicionalmente a las hojas de estilo CSS, para controlar tanto la apariencia (colores, fuente, fondo) como el formato de su sitio web. Utilice esta opción para exportar plantillas, hojas de estilo CSS e imágenes asociadas a una carpeta. Esto puede hacerse para abrir y modificar las plantillas utilizando un software de terceros, e.g. Macromedia Dreamweaver o XMLSPY.

Plantillas Dreamweaver



El CatGen está estrechamente ligado a Macromedia Dreamweaver (o Dreamweaver Ultradev). Usted puede crear plantillas muy llamativas exportando una plantilla CatGen hacia una plantilla Dreamweaver, haciendo cambios en Dreamweaver, y luego importándola de regreso a CatGen. 

Este tópico es cubierto a profundidad en Introducción a la interfase  CatGen/Dreamweaver .

 

Utilería de la Base de Datos



La aplicación CatGen incluye tres utilerías de la base de datos:

Comprimir: La utilería Comprimir puede ser usada para comprimir el archivo (MDB) asociado con la base de datos de la empresa.

Respaldo: La utilería Respaldo puede ser usada para crear un respaldo de la base de datos de su empresa.

Restaurar: Esto puede ser utilizado para restaurar la base de datos desde el archivo de Respaldo si el archivo de la base de datos está dañado por cualquier motivo.

Comprimir



1. Hga click en File > Database Utilities > Compress.

Un cuadro de mensaje es exhibido con el mensaje “La sesión actual será cerrada. Continuar?

2. Haga click en Si en el cuadro de mensaje para comprimir la base de datos actualmente abierta.

CatGen comprime el archivo de la base de datos. Ahora usted puede pasar a trabajar con su catálogo web.  

Respaldo 



Esta función es utilizada para hacer un respaldo de su base de datos de la empresa. Se recomienda altamente hacer respaldos regularmente de su base de datos. Usted puede recuperar la base de datos con el comando Restauración de Base de Datos. 

Respaldando la base de datos de su empresa 

1. Haga click en File > Database Utilities > Backup.

El cuadro de diálogo Utilería de la Base de Datos es exhibido 
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2. Especifique la vía y el nombre de archivo del archivo de respaldo ha ser creado.

3. Haga click en Aceptar para crear el archivo de respaldo.

 

Note que usted puede cambiar la vía predeterminado (localidad) de sus archivos de respaldo en la Pestaña de Respaldo de los configuración de su programa.

Restaurar 



Esta función es utilizada para restaurar la base de datos de su empresa desde una copia de respaldo. Usted utilizará esto en caso de pérdida de datos o de error severo de ingreso de datos en su base de datos. 

Note que aún que nunca haga una copia de respaldo, siempre puede obtener la versión más reciente de la base de datos que usted ha publicado en catgen .com, con el comando Crear/Actualizar catálogo web bajo Opciones Avanzadas. 

Restaurando la base de datos de su empresa desde una copia respaldada. 

1. Haga click en File > Database Utilities > Restore.

El cuadro de diálogo Utilería de Base de Datos es mostrado.

2. Ingrese la vía del archivo de respaldo desde el cual desea restaurar la base de datos. También puede hacer click en el botón de Navegar para seleccionar el archivo. 

3. Haga click en Aceptar para restaurar la base de datos desde el archivo de respaldo.

Un mensaje es mostrado advirtiendo que todos los datos en la base de datos abierta actualmente será perdida.
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Toda la información de la base de datos actual será perdida!.  Continuar?

4. Haga click en Si si desea rescribir la base de datos con los datos del archivo de respaldo.

Salir



Haga click en File > Exit para salir del software CatGen.

Editar Opciones de Menú



Editar Menú tiene cuatro opciones. Cada una de estas opciones se describen brevemente abajo. Las opciones Cortar, Copiar y pegar funcionan como lo hacen en todas las aplicaciones de Windows.

Cortar – Cuando usted hace click en  Edit > Cut, el texto seleccionado es removido de su lugar y colocado en una tablilla de apoyo. Este texto entonces puede ser pegado en otro lugar. Este método es utilizado para mover texto de un lugar a otro.

Copiar – Cuando usted hace click en Edit > Copy, el texto seleccionado es copiado en una tablilla de apoyo. Este texto entonces puede ser pegado en otro lugar. Este método es usado para copiar texto de un lugar a otro.

Pegar – Cuando usted hace click en Edit > Paste, el texto en la tablilla de apoyo es insertado en el lugar que esté el puntero de inserción.

Configuración de Programa – Cuando usted hace click en Edit > Program Settings, aparece el cuadro de diálogo Configuración de Programa el cual tiene cuatro pestañas: Idioma, Conexión, Campos Adicionales y Campos Invisibles. La pestaña de Idioma le permite cambiar el idioma del programa, en el cual acostumbraba ver el software CatGen. La pestaña de Conexión le permite cambiar sus configuración de conexión de Internet.

Formulario de Configuración del Programa 



Cuando usted hace click en Edit > Program Settings, el cuadro de diálogo de configuración de Programa es mostrado, el cual tiene las pestañas de: Campos Adicionales, campos Invisibles, Respaldo, Idioma y Conexión. A continuación encontrará una descripción de éstas.

· Campos Adicionales : Aquí puede crear campos adicionales para guardar información del producto la cual será visible en el web. Para ingresar un valor para el campo, vaya a la pestaña de Adicional en el formulario de producto. 

· Campos Invisibles : Aquí usted también puede crear campos adicionales los cuales no estarán visibles en el web. Los valores para este campo pueden ser ingresados en la pestaña de Adicional en el Formulario de Producto. 

· Pestaña de Respaldo: Aquí usted puede especificar la carpeta en la cual los respaldos del archivo de la base de datos deben ser guardados, el período después del cual usted debe ser recordado para hacer un respaldo, y el número máximo de respaldos previos a ser guardados en la pestaña de Respaldo. 

· Pestaña de Idioma: Aquí usted puede ver y también cambiar el idioma actual del programa. El idioma del Programa es el idioma en el cual usted ve el software i.e. el idioma en el cual el texto en las opciones de menú, cuadros de diálogo y varios mensajes generados por el programa son mostrados. 

· Pestaña de Conexión:  Esta opción es utilizada para cambiar sus configuración de conexión de internet. Si usted usa un servidor proxy para conectarse al internet a través de una sistema local, usted puede ingresar el nombre del servidor proxy y del número proxy de puerto aquí. 

Pestaña de Idioma
 

Usted puede ver y también cambiar el idioma actual del programa aquí. El Idioma del Programa es el idioma utilizado para ver el software i.e. el Idioma en el cual el texto en las opciones de menú, cuadros de diálogo y varios mensajes generados por el programa son mostrados. Esto es diferente del idioma de datos en el cual usted ingresa la información de su empresa y productos. El idioma de los datos puede ser montado en el Formulario de la Empresa. El idioma predeterminado del Programa es el Inglés.

Para cambiar el idioma del programa:

1. Haga click en Edit > Program Settings.

El cuadro de diálogo de Configuración de Programa es mostrado.
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Lenguaje:
Lenguaje actual del Programa: Inglés
Lenguajes del programa

2. Haga click en la pestaña de Idioma.

3. Seleccione el Idioma del Programa de su elección de la lista drop-down de Idioma de Programa.

4. Haga click en Guardar y

5. Reinicie el software de CatGen para registrar el cambio de idioma.

Pestaña de Conexión
  

Esta opción es utilizada para cambiar sus configuración de conexión de internet. Si usted usa un servidor proxy para conectarse al internet a través de una sistema local, usted puede ingresar el nombre del servidor proxy y del número proxy de puerto aquí. Contacte a su administrador de sistema para obtener información sobre el nombre del servidor proxy y el nombre del puerto proxy. 
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Para cambiar sus configuración de conexiones de Internet

1. Haga click en Edit > Program Settings.

2. Haga click en la pestaña de Conexión.

3. Ingrese el nombre de su servidor proxy en el campo de Nombre Proxy.

4. Ingrese el número del Puerto Proxy en el campo Puerto Proxy, y  

5. Haga click en Guardar para cambiar los configuración.

Pestaña de Campos Adicionales 



Aquí usted puede crear campos adicionales para guardar información de productos la cual será visible en el web.

1. Haga click en Edit > Program Settings y haga click en la pestaña de Campos Adicionales en el cuadro de diálogo. 
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Configuración del programa:
Lenguajes / conección / Campos Adicionales / Campos invisibles / Respaldo
Inglés / Otro
2. Ingrese los nombres de campo para los campos adicionales que usted desee crear en la red.

3. Haga click en el botón de Guardar.

Para ingresar un valor para el campo, haga click en la pestaña de Adicional en el Formulario de Producto e ingrese el valoren el texto para el campo.

Pestaña de Campos Invisibles 



Aquí usted puede crear campos invisibles para guardar información de producto la cual será visible en el web.

1. Hga click en Edit > Program Settings y haga click en la pestaña de Campos Invisibles en el cuadro de diálogo. 
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2. Ingrese los nombres de campo para los campos invisibles que usted desea crear en la red.

3. Haga click en el botón de Guardar.

Para ingresar el valor para el campo, haga click en la pestaña de Adicional en el Formulario de Producto e ingrese el valor en el cuadro de texto para el campo.

Pestaña de Respaldo
 

Aquí usted puede especificar la carpeta en la cual los respaldos del archivo de la base de datos deben ser guardados, el período después del cual usted debe ser recordado para hacer un respaldo, y el número máximo de respaldos previos a ser guardados.
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Respaldo:
Carpeta de Respaldo / Buscar
Recordame para respaldar 7 días
No más de 5 previo al respaldo


Grabar / Cancelar / Ayuda

1. Ingrese el path de la carpeta predeterminada en la cual el respaldo del archivo para  la base de datos actualmente abierta de la empresa debe ser guardado, en el campo de Carpeta Predeterminada de Respaldo.

2. Ingrese el número de días después de los cuales debe ser recordado para hacer un respaldo en el campo Recuérdeme hacer Respaldo.

3. Ingrese el valor para el número máximo de respaldos que pueden ser guardados para la base de datos actualmente abierta en el campo No Guardar más que.....

Trabajando con el Árbol Web



Usted tiene acceso al árbol web seleccionando View  > Web Tree o haciendo click en el ícono de Mis Paginasen la barra de tareas [image: image64.bmp].

El árbol web muestra la estructura jerárquica de las páginas en su sitio web. Cada ítem en el árbol web representa una página. Cuando usted hace click en una página en el árbol web, se abre y se exhibe en el Panel de Contenido (la ventana del lado derecho). 

El hacer click con el botón derecho en cualquier ítem en el árbol web abre un menú automático, el cual permite agregar nuevas páginas al catálogo web, suprimir páginas y cambiar el orden en el cual aparecen los ítems en su sitio web.

Trabajando con el árbol web 

La barra de herramientas del árbol web tiene los siguientes botones:

[image: image65.bmp] Agregar Nueva Página de Productos: Haga click en este botón para agregar una nueva página de productos. Una página de productos puede ser agregada únicamente a una línea de producto. Seleccione la línea de producto a la cual será agregada la página de producto, y luego haga clic en este botón.

[image: image66.bmp] Agregar Página de Informe: Haga click en este botón para adjuntar una página de información de usuario a una página en su catálogo web. Las páginas de información de usuario pueden ser adjuntadas a cualquier ítem excepto a una página de historia. Para adjuntar una Página de información de usuario, seleccione el ítem en el árbol web al cual será adjuntada la página, y luego haga click en este botón.

[image: image67.bmp] Agregar Página de Línea de Producto: Haga click en este botón para adjuntar una página de línea de producto a una página en el catálogo. Las páginas de línea de producto pueden ser adjuntadas a cualquier página de información o a otra página de línea de producto. Para adjuntar una página de línea de producto seleccione el ítem en el árbol web al cual la página de línea de producta será adjuntada, y luego haga clic en este botón.

[image: image68.bmp] Agregar Página de Historia: Haga click en este botón para adjuntar una historia a una página en el catálogo. Las historias pueden ser adjuntadas a cualquier página incluyendo otra página de historia. Para adjuntar una historia, seleccione el ítem en el árbol web al cual la historia será adjuntada, y luego haga click en este botón.

El menú de contexto del árbol web  

El hacer clic con el botón derecho en un ítem en el árbol web abre un menú automático cuyas opciones son discutidas abajo: 
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Adicionar Página de línea de producto
Adicionar página de Información
adicionar página de historia
Borrar página
Adicionar nuevo producto
Suprimir Página: Esta opción puede ser utilizada para remover un ítem del árbol web. Para remover un ítem del árbol web, primero haga click en ese ítem para seleccionarlo y luego haga click con el botón derecho en el ítem en el árbol web y seleccione esta opción del menú automático.

Mover Página Arriba: Esta opción puede ser usada para mover ítems hacia arriba en el árbol web para cambiar el orden en el cual aparecen con ítems en el mismo nivel de jerarquía en el árbol web. Haga click en este botón para mover el ítem actualmente seleccionado sobre el ítem que le precede en el mismo nivel de jerarquía en el árbol web.

Mover Página Abajo: Esta opción puede ser usada para mover items hacia abajo en el árbol web para cambiar el orden en el cual aparecen con items en mismo nivel de jerarquía en el árbol web. Haga clic en este botón para mover el ítem actualmente seleccionado debajo del próximo ítem en el mismo nivel de jerarquía en el árbol web.  

 

Tipos de páginas web 



Hay 7 diferentes tipos de páginas web. Usted controla el contenido de cada tipo de página ligeramente diferente, como se describe abajo. Usted controla la posición de cada página en su sitio web desde su Árbol web.

Algunos tipos de páginas tiene contenido que es exclusivamente controlado en la  Pestaña de Diseño de la página; mientras otros tipos de páginas (particularmente páginas de línea de productos y productos) tiene contenido que es determinado automáticamente por el contenido de su base de datos de los productos en el formulario de Todos los Productos. En ultimo caso, usted todavía puede agregar contenido (texto o imagen) sobre o debajo del contenido generado automáticamente.

Usted controla los hipervínculos que CatGen coloca en sus páginas web ya sea cambiando la posición de la página en su árbol web, agregando una página de Historia como una subpágina, o sino desde la Pestaña de Vínculos.

Si usted desea controlar el contenido de las secciones generadas automáticamente de cada página (páginas de línea de productos y productos), véase el Introducción a las Plantillas CatGen  en la sección de Tutorial Avanzado.

Cómo controlar el contenido de cada tipo de página 

	Icono 
	Tipo de Página 
	Cómo controlar el contenido  

	[image: image69.bmp]
	Su Página de Inicio   
	Una página de inicio se comporta muy similarmente a una página de Línea de Producto, en la cual cualquier producto que sea reemplazado por debajo de ella aparece en su página. Esto es para que usted pueda colocar “Productos Peculiares”en su página de inicio (productos que desee resaltar). Esto es estrictamente opcional. 

Así usted defina o no productos peculiares, usted ingresa el contenido de su página de inicio (texto e imágenes) en la  Pestaña de Diseño

	[image: image70.bmp]
	Página de Información 
	Usted puede colocar páginas de información en cualquier lugar de su árbol web, y ellos normalmente serán vinculados desde la página principal (por ejemplo, la página de “Políticas” una subpáginas de la página de inicio, es vinculada desde y hacia la página de inicio).

Usted crea el contenido de una página de información en la Pestaña de Diseño

	[image: image71.bmp]
	Página de Historia 
	Una página de historia es muy similar a una página de información, excepto que una página de historia puede aparecer muchas veces en su sitio en diferentes lugares. Usted crea historias en el Formulario de historias y luego usted arrastra y coloca en su árbol web. Cada página en su sitio que tiene una página de historia adjuntada a ella tendrá un vínculo a la historia en la sección “Historias Relacionadas” de la página. Usted también puede, por supuesto, crear un vínculo a la Página de Historia (o hacia cualquier otra página) desde el comando “Agregar vínculo a una página interna” de la Pestaña de Diseño.

	[image: image72.bmp] 
	Contactar Página 
	La página de Contacto contiene información acerca de su empresa (dirección, número de teléfono, etc.). Su página de contacto normalmente es generada automáticamente desde la información desde su base de datos, pero usted puede agregar contenido sobre o debajo de la información generada automáticamente  en la pestaña de Diseño. Véase abajo si usted desea corregir la información de su página de contacto. 

	[image: image73.bmp]
	Página de Línea de Producto 
	Una página de línea de producto es una página que contiene otros productos u otras líneas de producto. Usted agrega contenido a una página de línea de producto arrastrando y colocando desde el formulario de Todos los Productos al árbol web. Esto agrega a las imágenes del tamaño de uña de los productos y a la información básica de producto para cada producto (precio, nombre, código) a la página.  Usted puede agregar contenido especial sobre o debajo de la información generada automáticamente desde la Pestaña de Diseño.

	[image: image74.bmp] 
	Página de Producto  
	Una página de Producto siempre está vinculada a un producto en su base de datos. Usted crea una página de producto arrastrando y colocando un producto en el Formulario de Todos los Productos en el árbol web, o sino, haciendo click con el botón derecho en el árbol web y seleccionando el comando Agregar nuevo producto. 

	[image: image75.bmp]
	Página de Lista de Vendedor 
	Una página de Vendedor siempre está vinculada a una lista de vendedor en su base de datos. Usted crea una página de vendedor arrastrando y colocando al Vendedor en el Formulario de Todos los Vendedores en el árbol web, o sino haciendo click en el botón derecho del árbol web y seleccionando el comando Agregar nuevo Vendedor. 


 

Cómo corregir la información de su página de contacto 

1. Haga invisible la página de Contacto (retire el visto de la propiedad “visible” en la pestaña de Propiedades de página) 

2. Cree una nueva página de información por debajo de la página de inicio, y llámela, “Contacto”   

3. Ingrese su información de contacto en la pestaña de Diseño.

 

Qué son páginas principales y subpáginas 

Si una página web contiene vínculos a otras páginas web, nosotros llamamos a la página Principal y las páginas vinculadas subpáginas. Para crear la jerarquía de páginas y subpáginas web:   

· Haga click con el botón derecho en cualquiér página en el árbol web y seleccione del menú la opción para agregar una Página de información o una página de Historia. La nueva página se convierte en una subpágina de la página bajo la cual está agrerada (página principal). Para detalles véase trabajando con el árbol web.
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El árbol web mostrando una subpágina por debajo de la página Acerca de 

· Si una página existente va ha ser convertida en subpágina, seleccione la página principal en el árbol web y agregue un vínculo en la sección apropiada utilizando la pestaña de vínculos del formulario de página web. Para detalles Pestaña de vínculos.
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Enlace / Otros
Enlaces por defecto solamente

Enlaces
Todas las páginas


Enlaces Externos


Nombre del Sitio


Sitio URL


Agregando vínculo desde la pestaña de vínculos 

· Usted también puede modificar la jerarquía de página principal subpágina arrastrando el ícono de una subpágina en el árbol web y colocándolo sobre el ícono de la página principal.

Propiedades de Página



Acceda a esto desde la pestaña de Propiedades de Página de cualquier página web. 
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Identidad de Página: El código interno de CatGen de su página web. Esto determina el URL (dirección de la página web) de la página de su sitio web. Por ejemplo si la Identificación de la página es 99, el URL de la página publicada normalmente es http://catgen.com/yourcompany/EN/99.html.

Nombre: El nombre de su página web. Este nombre identifica de manera única a la página dentro del catálogo web y también es exhibido como un hipervínculo en su sitio web.
Keyword Meta Tags: Los Keyword meta tags son etiquetas html que usted puede colocar en su página html para la optimización de interrogantes de los motores de búsqueda. Usted debe ingresar palabras que describan significativamente a su página web en este campo.  La meta es que los usuarios del web quienes utilizan motores de búsqueda (como Yahoo) encuentren su página web, en otras palabras que su página web esté enlistada en los resultados de la búsqueda. Note que todos los sitios web de vendedores CatGen pagados son automáticamente indexados por los mayores motores de búsqueda. Sin embargo este proceso puede tomar algún tiempo después de que la página web es publicada (hasta 12 semanas). Para más información véase el tópico Indexando su sitio web.  

Description Meta Tags: Description Meta Tags son similares a los Keywords Meta Tags (véase arriba). Usted debe ingresar una breve descripción de su página web en este campo.

Visible: Si este cuadro es señalado la página web será exhibida en el catálogo web, de lo contrario la página permanece escondida.

Plantilla Master: Esta lista drop-down le permite escoger una plantilla para la página web la cual determina la apariencia general de la página como encabezado, barra de navegación y esquema. Para más información véase el tópico Introducción a las Plantillas CatGen en el Tutorial Avanzado.

Plantilla Cuerpo: Escoja una plantilla de la lista drop-down. La plantilla cuerpo describe la apariencia del centro de la página. Para más información Introducción a Plantillas CatGen.

Protección de Clave: La página web en el catálogo puede tener protección de clave seleccionando este cuadro. El usuario del web tendrá acceso a su página solo después de escribir una clave que usted asigne. Nota: Esta característica aún no se implementa.

Generar una Lista de producto desde un informe SQL: Usted puede selecionar este cuadro para generar automáticamente los productos en una línea de productos. Usted necesitará ingresar una Interrogante SQL en el cuadro “Seleccionar*Desde Productos Donde...” y luego haga click en el botón “Generar Ahora” . Para más información vea el tópico Interrogantes SQL en la sección de Tutorial Avanzado.

Seleccione * desde productos: La condición de filtro para la cláusula DONDE de la interrogante SQL (véase arriba).

Pestaña de Vínculos



Esta pestaña puede ser utilizada para modificar los vínculos que son mostrados en la barra de navegación que aparece a la izquierda de cada página en su catálogo web. La hoja de pestaña para esta pestaña tiene los botones Principal, Navegar, Historia, Producto y Otros correspondientes a diferentes secciones en la barra de navegación. El hacer click en cualquiera de estos botones muestral los vínculos presentes por defecto en la sección correspondiente de la barra de navegación, en el cuadro de Vínculos en la hoja de pestañas. E.g. El hacer click en el botón de Buscar en la pestaña de Vínculo mostrará los vínculos en la sección de Búsqueda de la barra de navegación, en el cuadro de Vínculos. 

Para agregar un vínculo en la barra de navegación:

1. Haga click en la página en el árbol web para traer el formulario de página web para la página.

[image: image78.png]Page Proparties Links | Design | Souce Code | Preview
Main | Browse | Stoy | Product | Other
% DefaultLinks Only

AllPages Links

il

‘ 3

Help




2. Haga click en la pestaña de vínculo en el formulario de página web.

3. Ahora haga click en el botón que corresponde a la sección de la barra de navegación en la cual desea agregar el vínculo. 

E.g. para agregar un vínculo a la sección de Productos Relacionados, haga click en el botón de Producto en la hoja de pestaña. El cuadro de Todas las Páginas muestral la lista de todas las páginas en el catálogo web.  
4. Remueva el visto del cuadro de Sólo Vínculos.

5. Seleccione el ítem correspondiente al vínculo al que usted desea agregar, en el cuadro de Todas las Páginas en la hoja de vínculo y haga clic en el botón [image: image79.bmp].

El ítem es copiado en el cuadro de vínculos.

6. Haga click en Guardar. 

Agregando un vínculo a una página que no está en el catálogo web 

1. Haga click en el botón Agregar Nuevo Vínculo Externo en la hoja de pestaña.

2. Escriba un nombre para el vínculo en el cuadro de texto Nombre del Sitio y escriba el URL del vínculo en el cuadro de texto URL de Sitio.

El nombre que usted escribió es agregado al cuadro de Vínculos.

3. Haga click en Guardar.

Para remover un vínculo de la barra de navegación:

1. Haga click en la página en el árbol web para traer el formulario de la página web para la página.

2. Haga click en la pestaña de vínculo en el formulario de página web.

3. Haga click en el botón para la sección de la barra de navegación, desde la cual será removido el vínculo.

4. Seleccione el ítem correspondiente al vínculo en el cuadro de vínculo de la hoja de pestaña.

5. Haga click en el botón Suprimir Vínculo.

El ítem es removido del cuadro de vínculos.

6. Haga click en Guardar.
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Usted puede utilizar el botón [image: image80.bmp]  para copiar todos los ítems en el cuadro de Todos los Vínculos. Usted puede usar el botón [image: image81.png]


 para remover todos los ítems del cuadro de Vínculos. 

Pestaña de Diseño



La mayoría de su trabajo será hecho en la pestaña de Diseño. Note que cierto tipo de páginas (principalmente páginas de Producto y páginas de líneas de producto) tienen contenido que es definido por defecto (véase tipos de páginas para detalles), pero usted todavía puede insertar contenido en la parte superior o inferior de la página. 

Editando su página web 

Haga click en la página que quiere editar en el árbol web y luego haga click en la pestaña de Diseño. Dependiendo del tipo de página que usted ha escogido, usted podrá editar las secciones de Encabezado y Pie de Página.
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1. Si usted tiene un sitio web de idioma múltiple, haga click en la pestaña apropiada de idioma. 

2. Seleccione un bloque de texto y haga click en un de las herramientas de Diseño listadas abajo; o sino haga clic en una de las herramientas de diseño y siga el diálogo. 

Herramientas de Diseño disponibles en la barra de menú de la pestaña de Diseño  

Haga click en cualquiera de los íconos de herramientas de diseño para conseguir el efecto de texto deseado. 
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Cambio de Fuente
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Fuente / Estilo / Tamaño
Cuando hace click en el botón de fuente en la pestaña de diseño el cuadro de diálogo de Fuente es exhibido, el cual puede ser utilizado para modificar la apariencia del texto de la página.

1. Seleccione el texto que usted quiere formatear y luego haga click en el botón de Fuente.

2. Seleccione una fuente de la lista de fuentes. La fuente del texto define la apariencia  de los caracteres.

3. Seleccione un estilo de fuente. El estilo de fuente decide si el texto tiene una apariencia regular o si es en negrilla o en cursiva.

4. Seleccione un tamaño de fuente escogiendo de la lista o escribiendo un valor en el campo.

5. El texto seleccionado puede ser subrayado escogiendo el cuadro de Subrayar.

6. También puede seleccionar un color de fuente para el texto desde la lista drop-down de Color o haciendo click en el botón Cambiar Color.

Usted puede ver una muestra de como el texto aparecerá en el cuadro de diálogo.

Negrilla, Cursiva, Subrayar

Seleccione el texto que usted desea formatear y haga click en el botón apropiado para poner en negrilla, cursiva o subrayar el texto seleccionado. Usted también puede aplicar estas características utilizando el cuadro de diálogo de Fuente el cual aparece cuando usted hace click en el botón de Fuente en la barra de herramientas.

Numeración y Viñetas

Seleccione el texto de la lista y haga click en el botón apropiado en la barra de herramientas para obtener una lista de viñetas o numeración. Este botón trabajará a modo de pasador, i.e. usted puede utilizarlo para formatear la lista y también para remover el formateo de la lista.  
Justificar

Este formateo se aplica a un párrafo entero o a todos los párrafos seleccionados . Seleccione los párrafos a los cuales desea cambiar la alineación horizontal y haga click en uno de los botones de Alinear a la Izquierda, Centrar o Alinear a la Derecha en la barra de herramientas para cambiar la alineación del párrafo seleccionado.

Insertar Imagen
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Este cuadro de diálogo es exhibido cuando usted hace click en el botón de Insertar Imagen en la barra de herramientas en la pestaña de Diseño del formulario de la página web. Usted puede insertar imágenes existentes en la base de datos de la empresa o imágenes de archivos en el disco dentro de su página web.


Imagen:
Base de datos
/ Disco
Nombre


Insertar Captura
Texto alternativo
Esquema: Alineamiento / Bordes
Espaciamientos: Horizontal  /  Vertical


Insertando una imagen:

1. Haga click en el botón Insertar Imagen para mostrar el cuadro de diálogo de Insertar Imagen.

2. Haga click en uno de los dos botones de opciones: Disco o Base de Datos dependiendo en si desea obtener una imagen existente en la base de datos o una imagen de un archivo de disco.

3. Si usted hizo click en el botón de opción Base de Datos, seleccione una imagen de la lista de imágenes. 

4. Si usted hizo click en el botón de opción Disco, entonces haga click en el botón Navegar para seleccionar una imagen de una carpeta en su disco. 

Seleccione la opción Desde Disco para insertar una imagen en la página actual desde un archivo de disco.

Fuente de Imagen: Ingrese la vía del archivo de imagen (GIF, JPG o BMP) que usted desea insertar en la página. Usted también puede usar la Navegación para seleccionar el archivo de imagen.

Dimensionar Imagen a: Especifique un tamaño al cual desea que su imagen sea dimensionada. 

5. Ingrese un Titular para membretar la imagen y cualquier descripción adicional en el campo Alternar Texto.

6. Seleccione un alineamiento par especificar la posición relativa de la imagen en la página de la lista de Alineación drop-down.

7. Si usted desea tener un borde alrededor de la imagen, ingrese un valor en el cuadro de texto Grosor de Borde. El valor debe estar en unidades de puntos (1 punto = 1/72 pulg).

8. Ingrese un valor para el espacio entre imagen y texto en la posición de inserción del puntero en los cuadros de texto de Espacio Horizontal y Vertical. El valor debe estar en unidades de puntos.

9. Haga click en Insertar par insertar la imagen en la página o en Cancelar, para no insertar la imagen.

Cuando usted hace clic en el botón Insertar Imagen, el cuadro de diálogo de Insertar Imagen es exhibido. Seleccione una de las opciones -Desde Base de Datos o Desde Disco- en el cuadro de diálogo.

Insertar Tabla

El hacer click en el botón Insertar tabla en la pestaña de Diseño de un formulario de Información de Usuario o un formulario de Línea de Producto muestra el cuadro de diálogo de Insertar tabla. Usted puede utilizar este cuadro de diálogo para insertar una tabla y también definir sus atributos.
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Tablas:

Capturar tabla
Número de filas
Númera de columnas
Bordes
Ancho 
Atributos de Celda
Para insertar tabla

1. Ingrese un título para la tabla que aparezca arriba en el campo titular de Tabla.

2. Ingrese el número de filas para la tabla en el campo Número de Filas.

3. Ingrese el número de columnas para la tabla en el campo Número de Columnas.

4. Ingrese el grosor del borde de la tabla en el campo Grosor de Línea.

5. Ingrese un valor par el ancho de cada columna de la tabla en el campo Ancho.

6. Attr de Celdas

7. El relleno de Celdas especifica el espacio vertical entre las celdas de la tabla. 

8. Ingrese un valor para el espacio entre celdas si lo desea en el campo Espacio de Celdas.

 

Insertar Objeto

Haga click en el botón insertar objeto para insertar un objeto en la barra de herramientas de diseño.

El formulario de Insertar objeto se abre con una hoja de pestaña de objeto.

Usted puede insertar un objeto de la base de datos de objetos seleccionando un objeto de la lista de objetos exhibidos.

Usted también puede seleccionar una imagen del disco. Para esto o escribe la vía del objeto en el cuadro de texto Fuente de Objeto o hace click en el botón Navegar en el cuadro de diálogo para especificar la vía.

Seleccione el botón Guardar objeto en base de datos para guardar el objeto seleccionado en la base de datos.

Línea Horizontal 

Haga click en el botón Insertar línea Horizontal para insertar una línea horizontal en la posición del puntero de inserción. Para suprimir una línea usted puede utilizar la tecla Suprimir o Regresar un espacio.

Insertar Hipervínculo (a otro sitio web)
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Información del Hipervínculo:
Tipo
URL
Para insertar un vínculo a una página externa (que no está en su catálogo web)

1. Haga click en el botón Insertar Hipervínculo en la barra de herramientas.

2. Seleccione un protocolo de la lista drop-down Escribir.

3. [image: image165.png]


Ingrese el URL (dirección de la página) en el cuadro de texto URL y haga click en Aceptar.

Insertar Hipervínculo (a una página en su sitio)

Página:
Captura de enlace

Insertar / Cancelar / Ayuda
Para insertar un vínculo a una página en su catálogo web:

1. Haga click en el botón Insertar Vínculo a la Página en la barra de herramientas.

2. Ingrese el texto del hipervínculo en el campo Titular de Vínculo. 

3. Seleccione la página a la que usted se quiere vincular desde la red y haga click en el botón Insertar para insertar el vínculo.

Pestaña de Código Fuente 



La aplicación CatGen automáticamente genera el código de fuente para crear una página web con el contenido que usted especifica en la Pestaña de diseño. Si usted conoce el html, usted puede ver y modificar el código generado en la pestaña de fuente.   

Si usted ha especificado más de un idioma en su sitio web, usted tendrá una pestaña de fuente para cada idioma que usted especifique en su sitio web. Para más información véase Sitios web de idioma múltiple.

Modificando el código html para su página 

1. Haga click en la pestaña de Fuente para la página que usted quiere modificar. 
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2. Si su sitio web tiene más de un idioma, haga click en la subpestaña adecuada de idioma.

3. Usted puede modificar cualquier código html y ver los resultados en la pestaña Preview. 

Si usted desea que su código html se envuelva en la ventada, haga click en el botón Envolver Texto.

 Pestaña Adicional 
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Adicional:
Descripción de la compañía
Seleccionar logo
Ancho
Alto
Descripción de la Empresa: Usted puede ingresar una descripción acerca de su empresa en el cuadro.

Haga click en el botón de Seleccionar Logotipo para seleccionar una imagen para ser utilizada como logotipo de la empresa, el cual será exhibido en la parte superior de cada página.

Ancho: El ancho del logotipo seleccionado de la empresa en pixels es mostrado en pixels.

Alto: El alto del logotipo seleccionado de la empresa en pixels es mostrado en pixels.

Tamaño: El tamaño del logotipo seleccionado de la empresa en pixels es mostrado en pixels.  

 

Pestaña Preview 



La pestaña Preview otorga una vista WYSIWYG (What You See Is What You Get / Lo que Ve es lo que Obtiene) de su página. Usted puede ver exactamente como su página aparecerá cuando sea vista en un navegador de web.

 

La pestaña Preview también tiene una barra de herramientas con los botones siguientes:

Atrás: Haga click en este botón para regresar a la página vista previamente.

Adelante: Haga click en este botón para regresar a la página en la cual estaba cuando hizo click en el botón Atrás para venir a la página actual.

Imprimir :  Haga click en este botón para enviar la página que usted está viendo a la impresora.

Formulario de Empresa



Se accede a este formulario seleccionando Catalog > Company, o haciendo click en el Icono de Empresa en la barra de tareas [image: image101] [image: image102.bmp] . 

El formulario de empresa está hecho de 5 pestañas, para más información:  

· La Pestaña Básica es donde usted puede ver el Nombre de su Empresa, Código de Empresa y modificar la clave para abrir la base de datos de la empresa. Usted también puede actualizar los datos de la empresa con ella guardada en su servidor CatGen.

· La Pestaña Adicional es donde usted puede ingresar una descripción acerca de su empresa y también seleccionar un logotipo el cual será exhibido en sus páginas web.

· La Pestaña de contacto es donde usted puede ingresar el nombre, dirección, teléfono, fax e e-mail para la persona de contacto de la empresa. 

· La Pestaña de dirección es donde usted tiene campos en los cuales usted puede ingresar la dirección completa de la empresa.

· La Pestaña de Configuración es donde usted puede ingresar diferentes configuraciones para el sitio web de su empresa; como escoger el idioma para el sitio web, habilitar el carro de compras, configurando visibilidad de e-mail y tamaños de imagen. También en la pestaña de configuración es donde usted configura su sitio web para idiomas múltiples, para más información Sitios web de idioma múltiple.

Si usted ha creado un sitio web de idioma múltiple, aparecerán pestañas adicionales en las cuales deberá traducir el nombre de su empresa al idioma correspondiente. 

 Pestaña de Dirección de la Empresa 
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Dirección:
Dirección 1
Dirección 2
País / Ciudad / Provincia
Código postal / Dirección alternativa Web
Los detalles de la dirección para la empresa pueden ser llenados en esta hoja de pestaña. Usted tiene dos campos para ingresar la dirección.

Línea1 de Dirección: Esta es la primera entre los dos campos provistos para ingresar la dirección de su empresa.

Línea2 de Dirección: Esta es la segunda entre los dos campos provistos para ingresar la dirección de su empresa.

País: Ingrese el país donde su empresa está ubicada.

Ciudad: Ingrese la ciudad donde su empresa está ubicada.

Provincia: Ingrese la provincia donde su empresa está ubicada.

Código Postal : Ingrese el código postal de la localidad donde su empresa está ubicada.

Dirección Alternativa de Web: Ingrese una dirección alternativa de web (URL) si puede encontrar alguna información adicional de su empresa.

Los valores que usted ingresa en estos campos son mostrados en la Pagina de Contacto de su catálogo web. 
Pestaña Información Básica de la Empresa 
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Usted puede encontrar los siguientes campos en esta hoja de pestaña:

Código de Empresa: En este campo usted puede ver el código de empresa, el cual escribió cuando registró la empresa. El código de la empresa no puede ser modificado.

Nombre de la Empresa: Usted puede ingresar o modificar el nombre de la empresa escribiendo el nombre de la empresa en este campo. 

Host Catgen Actual: El hacer click en el Host CatGen Actual muestra el nombre del servidor en el cual su catálogo web está alojado. Hay varios servidores CatGen en diferentes países. Si no hay un servidor CatGen específico para su país el servidor CatGen predeterminado es www.catgen.com .

Clave: Ingrese la clave para la base de datos de su empresa en este campo.

El hacer click en el botón Actualizar información de empresa desde base de datos host muestra el cuadro de diálogo Conectar. Si usted hace click en el botón Continuar, usted estará conectado a la base de datos del servidor CatGen y los datos de la empresa pueden ser leídos desde ahí a la aplicación de cliente CatGen.

Si el botón Corregir es hecho click, las modificaciones hechas en el formulario de Empresa son rescritas con los antiguos valores, la próxima vez que el catálogo web sea publicado. 
Pestaña de Contacto con Empresa 
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Cantácto:
Nombre de contácto
Contácto Técnico
Correo / Telefono / Fax
En esta pestaña usted puede ingresar información de contacto acerca de la/s persona/s de contacto. La información que será provista en los campos de pestañas incluye: 

Nombre de Contacto: Ingrese el nombre de la persona de contacto de la empresa que puede ser contactada para más información acerca de los productos de la empresa.

Contacto Técnico: Ingrese el nombre de la persona a ser contactada por motives técnicos relacionados al catálogo web.

Email: Ingrese la dirección de email de su empresa en la cual los clientes potenciales pueden contactarle.

Teléfono: Ingrese los números de teléfono de su empresa.

Fax: Ingrese los números de fax de su empresa.

La información ingresada en esta pestaña será mostrada cuando el vínculo de contacto, que aparece en cada página del catálogo sea hecho click.

Pestaña de Configuración de Empresa
 

Los campos presentes en esta hoja de pestaña están descritos a continuación:
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Primer Idioma de sitio web: Este es el idioma primario para los datos, en el cual el catálogo web será exhibido a los observadores.

Segundo Idioma: CatGen mantiene un idioma secundario alterno para datos, en el cual el catálogo web puede ser mostrado. Si un segundo idioma que no sea el Inglés es seleccionado se exhibirá una pestaña adicional en el formulario de Empresa con el mismo idioma escogido. En esta pestaña usted puede ingresar el Nombre de la Empresa y Descripción de la Empresa en el idioma secundario seleccionado.

Configuraciones de Email: Si se escoge la opción No mostrar dirección de email, el email de la empresa no será exhibido en el catálogo web para los observadores. Si la opción No mostrar dirección de email pero proveer cuadro de retroalimentación el escogido, la dirección de email no es mostrada a los observadores pero, el catálogo proveerá un cuadro de retroalimentación a través de la cual los observadores pueden enviar emails. Si la opción Mostrar dirección de email es seleccionada los observadores pueden ver la dirección de email de la empresa en la página de Contacto del catálogo web.

El Sitio Web tiene Carro de Compras: Si este cuadro es escogido el catálogo web tendrá carro de compras, donde los observadores del catálogo pueden agregar productos de su elección al acarro de compras y hacer pedidos para el mismo.

Guardar Imágenes de Tamaño Completo: Usted puede utilizar este cuadro para habilitar la agregación de imágenes de tamaño completo para sus productos. Usted también puede ingresar un tamaño predeterminado de la imagen principal y el tamaño predeterminado de la imagen de tamaño de uña (en pixels) aquí.

Moneda Predeterminada: Usted puede especificar una moneda predeterminada. Esto será utilizado para ingresar los precios de los productos.
Formulario de Todos los Productos
 

Cuando usted hace click en Catalog > Products, el formulario de Productos es mostrado. Este formulario tiene dos pestañas: Todos los Productos y Producto. Usted puede utilizar este formulario para agregar nuevos productos al catálogo web de su empresa, así como para modificar la información de producto para productos existentes en el catálogo y para suprimirlos. A continuación una breve descripción de las dos pestañas:

Pestaña de Todos los productos 

[image: image105.png]oot | ot |

Do
<0001 Mandat Stocl

xx0003  Cammood Eleph
}<0008  Camwood BatH
xxo008  Afican Celebrat
<0003 Batte Opener

<001 | Ebory Letter 0p

¥ Locate inWebTree

bew | Moty | ele Impor o other vendir





Cuando usted hace click en esta pestaña la hoja de pestaña muestra la red de Producto, la cual muestra todos los productos de todas las líneas de producto en el catálogo. En la red usted puede ver el Código de Producto y el Nombre del Producto para cada producto. Haga click en Nuevo para agregar un Nuevo producto, Modificar para modificar información del producto para un producto existente o Suprimir para suprimir un producto del catálogo. También tiene los botones Primero, Anterior, Siguiente y Ultimo para moverse entre los productos en la red de productos.

El hacer click en Nuevo hace a la pestaña de Producto activa y usted puede ingresar información para un nuevo producto. El hacer click en modificar también activa la pestaña de Producto y usted puede editar la información para el producto seleccionado en la red de producto. 

Para suprimir un Producto

1. Remueva todos los vínculos de la página desde el árbol web.

2. Seleccione el producto en la red de producto haciendo click en él.

3. Ahora haga click en el botón Suprimir y luego haga click en Si para confirmar la supresión en el cuadro de mensaje.

Pestaña de Producto

La hoja de pestaña de Producto le permite ingresar información acerca de un Nuevo producto o para modificar la información para un producto existente en el catálogo. Para más detalles haga click en Formulario de Productos.

Importando productos de otros vendedores

Usted puede importar productos de otros vendedores CatGen para vender en su propio sitio web. Esto puede ser útil si usted es, por ejemplo, un distribuidor o revendedor para otro vendedor CatGen, y desea evitar el tener que reingresar esa información de producto e imagen. 

Si esta característica está en gris, no está implementada en el lanzamiento actual.

Formulario de Producto



La pestaña de Product es donde usted modifica imágenes, atributos y precios de cada uno de sus productos. Usted accede a la pestaña de Productos seleccionando Catalog > Products o sino haciendo click en el ícono de Productos en la barra de tareas [image: image106.bmp]. Usted también puede obtener la pestaña de Producto seleccionando su producto en el árbol web y luego seleccionando la pestaña de Producto.  

La pestaña de Producto tiene 6 sub-pestañas. Para más información véase: 

· La Pestaña de Imagen es donde usted ingresa o cambia la imágenes de producto 

· La Pestaña Básica es donde usted ingresa o cambia información básica acerca de su producto ( Código de Producto, Nombre, Descripción) 

· La Pestaña Especificaciones ingresa las dimensiones de Producto, peso , colores, materiales, etc.   

· La Pestaña de Envío es donde usted ingresa el lugar de invención de su producto, la capacidad de producción, etc. 

· La Pestaña de Precios es donde usted ingresa sus Opciones de Producto, si las hay(tamaño y color), y precios. 

· La Pestaña de Adicional es donde usted ingresa campos adicionales, definidos por usted, pertinentes a sus productos. 

Note que si usted ha definido un Segundo o tercer idioma para su empresa, aparecerán pestañas adicionales en su sitio web para que usted ingrese las versiones del idioma alterno de las especificaciones de su producto (nombre, descripción). Para más información véase el tópico Sitios web de idioma múltiple. 

Pestaña de Imágenes de Producto
 

Especificando una Imagen Principal

1. Haga click en la pestaña de Imágenes en el formulario de Producto.
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2. Haga click en el botón de Imagen Principal en la hoja de pestaña.

Usted puede especificar dos imagines aquí: la imagen principal y la de tamaño de uña.

3. Haga click en el botón Seleccionar en el lado izquierdo para seleccionar la imagen principal.

4. Haga click en el botón Seleccionar en el lado derecho para seleccionar una imagen de tamaño de uña.

5. Para usar la imagen principal como una imagen de tamaño de uña asegúrese de que el cuadro de selección Usar imagen principal para tamaño de uña esté seleccionado y escriba un valor en el cuadro de Dimensionar imagen.

Si usted seleccionó el cuadro de Suprimir la imagen correspondiente al producto es suprimida de la base de datos.

Especificando una imagen Adicional

1. Haga click en la pestaña de Imágenes en el formulario de Producto.

2. Haga click en el botón Imagen Principal en la hoja d pestaña.

3. Haga click en el botón Nuevo.

4. Haga click en Seleccionar en el cuadro de diálogo de Propiedades de Imagen y luego seleccione una imagen con el cuadro de diálogo Abierto.

5. Ingrese un titular para la imagen en el cuadro Titular y el tamaño (en pixels) en el cuadro Dimensionar Imagen, si usted desea que la imagen sea dimensionada a un tamaño diferente.

6. Haga click en Aceptar para agregar la imagen a la lista de imágenes adicionales o haga clic en Cancelar para no agregar la imagen. 

Para Suprimir una Imagen Adicional 

1. Seleccione la imagen en la lista de imágenes adicionales y haga click en suprimir. 

Para modificar una Imagen Adicional  

1. Seleccione la imagen en la lista de imágenes adicionales.

2. Haga click en Modificar y luego cambia la imagen, su titular o tamaño en el cuadro de diálogo Propiedades de Imagen.

Especificando una imagen de Tamaño Normal 

Haga click en la pestaña de Imágenes en el formulario de Producto.

Haga click en el botón Imagen de Tamaño Completo en la hoja de pestaña.

Haga click en el botón Seleccionar y seleccione la imagen que será utilizada como la imagen de tamaño completo del producto y haga click en Guardar. 

Pestaña de especificaciones del Producto


Pestaña de Especificaciones
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En esta hoja de pestaña usted puede ingresar las especificaciones sobre el producto como su tamaño, peso y color entre otros. Los campos Longitud, Ancho, Alto, Diámetro y Peso en esta hoja de pestaña se explican por si solos.  

Longitud: Ingrese el largo del producto en el cuadro de texto. La longitud debe ser especificada en la unidad que usted ha seleccionado en la lista drop-down Unidad de Dimensión.

Ancho: Ingrese el ancho del producto en el cuadro de diálogo. El ancho debe ser especificado en la unidad que usted haya seleccionado en la lista drop-down Unidad de Dimensión.

Alto: Ingrese el alto de su producto en el cuadro de texto. El alto debe ser especificado en la unidad que usted haya seleccionado en la lista drop-down Unidad de Dimensión.

Diámetro: Ingrese el diámetro del producto en el cuadro de texto. El diámetro debe estar especificado en la unidad que usted ha seleccionado en la lista drop-down Unidad de Dimensión.

Peso: Ingrese el peso del producto en este cuadro de texto. El peso debe estar especificado en la unidad que usted ha seleccionado en la lista drop-down Unidad.

Unidad de Peso: Seleccione una unidad de peso de la lista drop-down.

Unidad de Dimensión: Seleccione la unidad que usted ha usad o para ingresar la longitud, ancho, alto y diámetro de la lista drop-down.

Material: En este campo usted puede especificar el material principal utilizado en el producto.

Detalles de Empaque: Aquí usted puede especificar el material y/o el método utilizado para empacar el producto.

Colores Dominantes: El campo Colores Dominantes hace referencia a los códigos Pantone de los colores dominantes del producto. Esto es útil porque el rendimiento del color del navegador no es confiable. 

Palabras clave: Usted puede especificar un o más palabras claves relacionadas al producto, las cuales serán usadas como meta tags para ayudar a localizar este producto cuando se haga una búsqueda en cualquiera de las palabras claves.

Comentarios: Aquí usted puede colocar cualquier tipo de información suplementaria para sumarse a la descripción ya provista en la pestaña Básica. 

También puede especificar las unidades para longitud, Ancho, Alto y Diámetro y también para Peso seleccionando la opción apropiada de las listas drop-down de la Unidad de Peso de la Unidad de Dimensiones. 

Pestaña Básica de Producto
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Código de Producto: Usted puede ingresar el código de producto aquí para un nuevo producto. El código de producto identifica de manera única al producto en su catálogo. Una vez que un código de producto sea ingresado no puede ser modificado después. Ingresar un valor en este campo es obligatorio.

Nombre de Producto: Usted puede ingresar o modificar el nombre de un producto aquí. El nombre del producto es exhibido como hipertexto (en el cual puede hacer click para abrir la página web para el producto). Ingresar un valor en este campo es obligatorio.

Descripción del Producto: Usted puede ingresar una descripción acerca del producto. Es importante ingresar una descripción adecuada del producto que sea tanto atractiva como informativa. El nombre y descripción del producto aparecen en la página web junto con las imágenes que usted agregó en la hoja de pestaña de imágenes. Ingresar una valor en este campo es obligatorio.

Historia del Producto: Ingrese una breve descripción de la historia del producto que lo pondrá en un contexto cultural.

Opciones de Producto
 

Si un producto tiene diferentes variantes seleccione la opción Producto con Opciones en la hoja de pestaña de Precios en el formulario de Producto. Las variantes de producto están basadas en alguna característica que lo distingue (e.g. Tamaño el cual puede ser Large o Médium). Usted tiene que agregar un Nombre de Opción para cada característica que lo distingue.

Especificando opciones para un Producto

1. Haga click en Catalog > Products, y seleccione un producto en la red de Productos.

2. Haga click en la pestaña de Producto y luego en la subpestña de Precios que está debajo de él.
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3. Haga click en Producto con Opciones y luego haga click en el botón Opciones.

El diálogo Modificar mi Producto es mostrado.

4. Haga click en el botón Nuevo.


En el cuadro de diálogo que aparece usted puede ingresar un Nombre de Opción, escoja si este valor debe ser obligatorio (el valor debe ser provisto) o no, especifique la interfase para ingresar valor de opción (botón drop-down o Radio), seleccione una imagen asociada con la opción y especifique el posible valor para la opción.

5. Ingrese el nombre para el cuadro de Nombre de Opción y haga click en el botón Agregar Valor de Opción.

El diálogo Agregar Nuevo Valor de Opción aparece.


Valor Opcional:
Nombre Opcional
Valor Opcional
Seleccionar imagen
Remover imagen
6. Ingrese un valor para la opción en el cuadro Valor de Opción y haga clic en Guardar.

7. Haga click en el botón Agregar Valor de Opción para agregar más valores para la opción.

8. Repita los pasos anteriores para agregar más opciones y valores para cada opción.

Las opciones que usted agregó son colocadas como campos en la red de Opciones de Producto.

Ingresando variantes para un producto 

1. Después de agregar opciones para el producto, haga click en el botón Agregar Línea para agregar una fila a la red de opciones de producto.

Cada fila en la red corresponde a una variante de producto

2. Ingrese valores para los diferentes campos en la red. 

3. Repita los pasos anteriores para cada variante del producto. 

Suprimiendo variantes de un producto  

1. Seleccione la fila en la red Opciones de Producto que corresponda a la variante de producto a ser suprimida.

2. Haga click en el botón Suprimir Línea.

Pestaña de Envío de Producto 



Pestaña de Envío
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En esta hoja de pestaña usted puede llenar información acerca de los detalles de inventario para los productos. Todos los campos en esta hoja de pestaña son opcionales. Usted puede o no ingresar valores en estos campos. Los siguientes campo están disponibles en esta hoja de pestaña:

Capacidad Mensual de Producción: Ingrese la capacidad promedio de productos producidos cada mes.

Tiempo de Preparación para envío: Este es el tiempo promedio tomado para despachar una encomienda del producto después que los pedidos para el producto son recibidos.

Ubicación de Almacenaje: Ingrese el lugar donde el stock del producto está disponible, i.e. el lugar desde donde el producto será enviado hacia el sitio del cliente. Esto puede indicar a un cliente potencial los cargos de envío del producto.  
Clase de Impuesto:

Fecha Introducida: Ingrese la fecha en la cual se ingresó la información de inventario arriba indicada al programa. Esta fecha es predeterminada a la fecha actual.

Pestaña de Precios de Producto 



Utilice este formulario para ingresar precios para sus. 

Cada uno de sus productos (u Opciones de Producto Individuales o SKUs de Productos) puede tener por lo menos tantos precios como Programas de Precios tiene. Usted mantiene programas de precios en el formulario Programas de Precios. Dependiendo de la Visibilidad del programa de precios, y de si el comprador web está registrado como un comprador CatGen mayorista, ellos verán el programa de precios más bajos que esté visible para ellos. Esto está explicado más adelante Programas de Precios Múltiples.

Usted puede mentalizar la pestaña de precios como sigue:

La sección superior de la pestaña de precios es donde usted coloca sus diferentes opciones de productos (SKUs individuales), en caso de ser aplicable. En el ejemplo abajo, un Producto Normal (un producto sin opciones), solo hay una línea con la cantidad en stock, número de SKU, y código de Tarifa Armonizada ( usted generalmente necesitará saber el Código de Tarifa Armonizada de su producto para propósitos de exportación, para más información véase Entrenamiento de Exportación CatGen).

La sección inferior es donde usted ingresa los precios de cada SKU individual o ítem de stock (SKU significa “Stock Keeping Unit” Unidad de Almacenamiento de Stock). Si usted tuvo más de un ítem SKU (por ejemplo un producto en colores rojo y verde, o un producto que puede ser vendido individualmente o en unidades de 4), usted podrá ingresar precios para cada SKU. Cada SKU en cambio puede tener por lo menos cuantas líneas de precios como Programas de precios tiene. Usted también puede ingresar precios de descuento por volumen de compra   especificando una cantidad mínima de pedido en cada línea.

La Pestaña de Precios de Producto
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Las opciones Producto Normal y Único en su tipo corresponden a productos que no tienen variantes y la opción Producto con Opciones es para productos que tienen diferentes variantes.

La red de Opciones de Producto tiene los campos: 

Cantidad en Stock: En este campo usted puede ingresar o modificar el valor para la cantidad actual en stock del producto o la variante de producto seleccionado.

Código de Tarifa Armonizada: Ingrese un código de tarifa armonizada para el producto ( o variante de producto) en este campo. Los Códigos de tarifa armonizada son utilizados para estandarizar productos para facilitar su exportación e importación, y formar la base para determinar trabajos, tarifas, etc.

SKU: SKU significa "Stock Keeping Unit" Unidad de Almacenamiento de Stock. La sección superior de la pestaña de pecios es donde usted coloca sus diferentes opciones de producto( SKUs individuales), en caso de ser aplicable. La sección inferior es donde usted ingresa los precios de cada SKU individual o ítem de stock.

Rango de Precio: El rango de precio para el producto (o variante de producto) es calculado por la aplicación basado en valores ingresados en la red de precios.

Si la opción Producto con opciones es seleccionada la red de Opciones de Producto permite ingresar información acerca de diferentes variantes de producto. Para ingresar información para diferentes variantes de producto véase el tópico de ayuda, Opciones de Producto.

Agregando o cambiando un precio para un producto 

1. Seleccione el producto de interés en el Formulario Todos los Productos (o de lo contrario seleccione el producto en el árbol web y haga click en la pestaña de Poducto).

2. Haga click en la pestaña de Precios.

3. Si su producto no tiene opciones, seleccione Producto Normal. Si su producto tiene opciones (como tamaño o color), seleccione Producto con Opciones y haga clic en el botón Opciones para cada variante del producto. Para detalles, véase Opciones de Producto.

4. Ingrese el SKU de Producto, si el producto tiene opciones, en el panel superior.

5. En el panel inferior, seleccione uno de sus programas de precios del drop-down e ingrese un Precio, valor para Precio Calculado, y para Moneda, si lo desea. 

6. Usted puede ingresar tantos precios como desee, para diferentes programas de precios, con valores para Cantidad Mínima de Orden y Cantidad Máxima de Orden.

7. Haga click en Guardar. 

Campos Adicionales de Producto
 

En este formulario usted ingresa valores para campos adicionales (atributos de producto) que aparecerán en su sitio web. Estos son campos como ISBN o Proveedores de Código que usted define por si mismo, que no están incluidos por defecto en los atributos estándar de productos CatGen. Usted define estos campos adicionales en Program Settings > Additional Fields tab .

Usted también puede definir campos adicionales para uso interno de su empresa que No están visibles en su sitio web (por ejemplo Código de Agente de ventas o Margen de Ganancia). Usted define estos campos en la pestaña Program Settings > Invisible Fields.
Formulario deTodos los Vendedores
 

Este formulario muestral todos los vendedores que usted ha ingresado en du Catálogo de Catálogos. Más información en Trabajando con su CoC...

Vendedores:
Código de compañía
Refrescar información de compañía
Nuevo / Modificar / Eliminar / Ayuda
Agregando un Vendedor a su CoC

1. Seleccione Catalog > All Vendors, o haga click en el ícono de Todos los Vendedores en la barra de tareas  [image: image111.bmp]
2. Ingrese el Código de Empresa CatGen del vendedor. 

3. Haga click en Guardar. 

Después de ingresar todos sus vendedores, haga click en Actualizar Información de Empresa para descargar información de contacto para todos sus vendedores a su base de datos local.

Formulario de Vendedor
 

Este formulario muestral la información detallada de Vendedores que usted ha ingresado a su Catálogo de Catálogos (CoC). No tiene que mantener esta información usted mismo, ya que es descargada del host de CatGen como se describe en el Formulario de Todos los Vendedores.
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Si usted desea descargar información de contacto para un solo vendedor, usted puede hacer click en Actualizar Información de Empresa desde el host. 

Más información acerca de Trabajando con su CoC...
Formulario de Historias



El hacer click en  Catalog > Stories muestra el formulario de Historias con las pestañas: Todas la Historias, Propiedades de Historia y Vínculos. Usted puede utilizar este formulario para agregar historias, suprimir historias y modificar propiedades de historias existentes. Abajo se da una descripción de este formulario:  

Pestaña de Todas la Historias
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Cuando usted hace click en esta pestaña la hoja de pestaña muestral la red de Historia, la cual contiene todas las historias del catálogo. La entrada de red es el Nombre de Historia de la historia. Haga click en el botón Nuevo para agregar una nueva historia, en el botón Modificar para modificar las propiedades de una historia existente o Suprimir para suprimir una historia del catálogo. Usted también puede tener los botones Primero, Anterior, Siguiente y Último para navegar a través de las historias en la red de Historia.

Haga click en el botón Nuevo para mostrar el formulario de Historia donde puede ingresar propiedades para una nueva historia. El hacer click en el botón Modificar también muestra el formulario de Historia y usted puede editar las propiedades de la historia seleccionada en la Red de Historia. Para aprender más acerca del formulario, haga click en el tópico de ayuda Formulario de Página Web para historia.

Para Suprimir una Página De historia:

1. Remueva todos los vínculos del formulario de Historia del árbol web haciendo click con el botón derecho y seleccionando la opción Suprimir Página.

2. Seleccione la historia en la red de historia haciendo click en ella.

3. Ahora haga click en el botón Suprimir y luego haga click en Si para confirmar la supresión en el cuadro de mensaje.

Pestaña de Propiedades de Historia

Esta es la misma que la Pestaña de Propiedades de Página de cualquier otra página web. 
Programa de Precios


Usted puede definir diferentes programas de precios para su empresa. Cada programa de precios especifica: 1) Cómo el precio para Un producto o su variante se ha determinado? Si el precio ha sido ingresado por el usuario o si ha sido calculado desde otro programa. 2) Moneda utilizada para el valor del precio. 3) Para qué usuarios el precio será visible: todos, usuarios registrados o únicamente usuarios registrados y aprobados. 4) Si el programa estará oculto de todos los usuarios.

Para crear un Nuevo Programa de Precios

1. Haga click en Catalog > Price schedules.

El cuadro de diálogo de Programa de Pecios es exhibido.
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2. Haga click en el botón Nuevo para ingresar un Nuevo programa.

3. Escriba un nombre por el cual el programa de precios sera identificado, a más del signo * que aparece en la lista de Programas.  

4. Si el precio de los productos para el programa es un precio calculado, seleccione el programa basado en el cual el precio será calculado en la lista drop-down de Programa Base.

5. Si usted seleccionó un programa base seleccione una opción entre Sumar, Multiplicar y Dividir e ingrese un número en el cuadro de texto para especificar como el precio para el programa es calculado desde el programa base.

E.g. Si el precio para el programa es 3 veces el precio del programa base, seleccione la opción Multiplicar e ingrese el valor 3 en el cuadro de texto.

6. Seleccione la moneda utilizada para el programa de precios de la lista de Moneda.

7. Seleccione una de las opciones para Visibilidad de Precios.

Esto dependerá de quién puede ver los precios: Usuarios Registrados, Usuarios Registrados y Aprobados o Público (todos).

8. Si el programa será oculto de todos los usuarios seleccione el cuadro Programa Oculto.

Esto se hará en caso de que el programa sea solo para su referencia y no para ser visto por los usuarios.

9. Haga click en Guardar.

10. Repita los pasos anteriores para agregar más programas y haga click en Cerrar cuando haya terminado de agregar programas de precios.

Para Suprimir un Programa de Precios

1. Haga click en Catalog > Price schedules.

2. Seleccione el programa de precios que se suprimirá en la lista de Programas.

3. Haga click en Suprimir.

El programa de precios se suprime y es removido de la lista de Programas.

Crear/Actualizar catálogo web



Esta opción le permite crear o actualizar su catálogo web en el servidor de web CatGen. Cuando usted escoge esta opción la aplicación de cliente CatGen se conecta al servidor CatGen y transfiere datos de la base de datos de la empresa que está actualmente abierta al servidor. Cuando usted hace click en Web > Create/Update web catalog, aparece el cuadro de diálogo de Conectar donde usted especifica el método utilizado para actualizar el catálogo web en el servidor.

El programa CatGen guarda toda la información que crea su sitio web en una base de datos en su computador local (esta base de datos reside en su directorio CatGen de programa y el llamado "xxx.mdb", donde "xxx" es su código de empresa). Cuando usted publica su sitio web, esta información es transferida a  CatGen.com. Así que mientras mantenga su sitio web actualizado, su información estará segura en catgen.com y usted podrá recuperarla del host aún cuando su computador se destruya. Para más información véase el tópico de ayuda Publicar catálogo web, Cuadro de diálogo de Opciones Avanzadas.

Note también que solo las páginas, productos o imágenes nuevas o cambiadas, se cargan en catgen.com cuando publica su catálogo. Usted puede darse cuenta qué páginas y productos serán publicados por el color de la página  en el árbol web. Las páginas y productos que están en rojo indican una página o producto que necesita ser publicada. Para más información véase el tópico sincronización de base de datos. 

Creando o actualizando su catálogo web:

1. Si usted aún no ha registrado su empresa en el servidor CatGen, haga click en  registrar su empresa para registrar. Esto es requerido antes de que pueda publicar su catálogo.

2. Conéctese al Internet.

3. Haga click en Web > Create/ Update web catalog.

El cuadro de diálogo Conectar aparece.
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4. Usted normalmente hace click en Continuar, lo cual publicará todos los productos nuevos o cambiados al sitio web CatGen.com. Si usted desea especificar otras opciones (como, recuperar una base de datos que previamente publicó a catgen.com, haga click en Cuadro de diálogo de Opciones Avanzadas y siga las instrucciones de ahí. 
Cuadro de Diálogo de Opciones Avanzadas 



Este cuadro de diálogo tiene tres botones de opciones para sincronización entre la aplicación de cliente CatGen y el servidor, como se describe a continuación:
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Copie la base de datos local a la base de datos del host y perderá los cambios en la base de datos del host: Esta es la opción predeterminada y cuando se la selecciona el catálogo web para la empresa en el servidor CatGen es rescrito con los datos de la base de datos de la empresa en el cliente.

Si el cuadro Suprimir base de datos del host primero está seleccionada, se suprime primero todos los datos en la base de datos del servidor y solo después de eso los datos son enviados de la base de datos del cliente.

Mezcle cambios entre las bases de datos local y del host: Cuando esta opción es escogida los datos de la base de datos de la empresa en el cliente CatGen, serán transferidos del cliente al servidor. 

Si el cuadro Reenviar todos los datos de producto, aún cuando parezca ser el mismo en las bases de datos local y del host está seleccionado, todos los datos en la base de datos de la empresa en el cliente es transferida al servidor. Pero si el cuadro no está seleccionado solo los cambios hechos en la base de datos de la empresa en el cliente CatGen serán transferidos del cliente al servidor después de la última sincronización con el servidor.

Copie la base de datos del host a la base de datos local y perderá los cambios en la base de datos local: Esta opción puede ser escogida si, deseamos que todos los cambios hechos a la base de datos de la empresa después de la última sincronización con el servidor sean removidos, para que los datos en la base de datos del cliente sea la misma que la que era al momento de la última sincronización.

Si el cuadro Suprimir base de datos local primero está seleccionado, todos los datos en la base de datos del cliente es suprimida primero y luego los datos de la base de datos de la empresa o del servidor es transferido a la base de datos del cliente.

Visualizar catálogo web en CatGen.net



Cuando usted hace click en Web > View web catalog on CatGen.net, el programa de cliente CatGen en su computador abre el navegador de web, se conecta a http://www.catgen.com y exhibe el catálogo web de su empresa en el servidor CatGen. Usted puede navegar las páginas web que usted creó en este catálogo. Esta opción funcionará solo si su conexión a Internet está activa. 
Trabajando con el árbol web



Usted accede al árbol web seleccionando View  > Web Tree o haciendo click en el ícono Mis Páginas en la barra de tareas.
El árbol web muestra la estructura jerárquica de las páginas en su sitio web. Cada ítem en el árbol web representa una página. Cuando usted hace click en una página en el árbol web, esta se abre y es exhibida en el Panel de Contenido (la ventana del lado derecho). 

El hacer click en cualquier ítem en el árbol web abre un menú automático, el cual permite agregar nuevas páginas al catálogo web, suprimir páginas y cambiar el orden en el que los ítems aparecen en su sitio web.

Trabajando con el árbol web

La barra de herramientas en el árbol web tiene los siguientes botones:

[image: image117.bmp] Agregar Nueva Página de Producto: Haga click en este botón para agregar una nueva página de producto. Una página de producto puede ser agregada únicamente a una línea de producto. Seleccione la línea de producto a la cual la página de producto será agregada, y luego haga click en este botón.  

[image: image118.bmp] Agregar Página de Información: Haga click en este botón para adjuntar una página de información de usuario a una página en su catálogo web. Las páginas de información de usuario pueden ser adjuntadas a cualquier ítem excepto a una página de historia. Para adjuntar una página de información de usuario, seleccione el ítem en el árbol web ala cual la página será adjuntada, y luego haga clic en este botón.  

[image: image119.bmp] Agregar Página de Línea de Producto: Haga click en este botón para adjuntar una página de línea de producto a una página en el catálogo. Las páginas de línea de producto pueden ser adjuntadas a cualquier página de información o a otra página de línea de producto.  Para adjuntar una página de línea de producto seleccione el ítem en el árbol web al cual la página de línea de producto será adjuntada, y luego haga clic en este botón.

[image: image120.bmp] Agregar Página de Historia: Haga click en este botón para adjuntar una historia a una página de historia en el catálogo. Las historias pueden ser adjuntadas a cualquier página incluyendo otra página de historia. Para adjuntar una historia, seleccione el ítem en el árbol web al cual la historia será adjuntada, y luego haga clic en este botón.

El menú de contexto del árbol web  

Al hacer clic con el botón derecho en un ítem en el árbol web abre un menú automático cuyas opciones son discutidas a continuación: 
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Suprimir Página: Esta opción puede ser utilizada para remover un ítem del árbol web. Para remover un ítem en el árbol web, primero haga click en ese ítem para seleccionarlo y luego haga click con el botón derecho en el ítem en el árbol web y seleccione esta opción del menú automático.

Mover Página Arriba: Esta opción puede ser utilizada para mover ítems hacia arriba del árbol web para cambiar el orden en el que aparecen con ítems en el mismo nivel de jerarquía en el árbol web. Haga clic en este botón para mover el ítem actualmente seleccionado por encima del ítem anterior al mismo nivel de jerarquía en el árbol web.

Mover Página Abajo: Esta opción puede ser utilizada para mover ítems hacia abajo del árbol web para cambiar el orden en el cual aparecen en el mismo nivel de jerarquía en el árbol web. Haga clic en este botón para mover el ítem actualmente seleccionado más abajo del siguiente ítem en el mismo nivel de jerarquía en el árbol web.

 

Visualizar Plantillas
 

Este comando muestra y permite visualizar y modificar sus plantillas Para más información véase el tópico Introducción a plantillas CatGen en el Tutorial Avanzado.

Ayuda



Hacer click en View > Help muestral la ventana de Ayuda en el panel del árbol. La ventana de ayuda muestra el tópico de Ayuda para el ítem actualmente seleccionado en el árbol web. Esta opción trabaja como un cierre, mostrando y removiendo la ventana de ayuda en el panel del árbol de su aplicación CatGen.

Reporte de Sumario de Productos



Hacer click en Reports > Product Summary muestra un submenú listando todos los reportes de Sumario disponibles. Si no se ha creado ningún reporte nuevo de sumario el submenú muestra una sola opción Todos los Productos.

Una reporte de sumario es un reporte tabular con una fila de cada producto seleccionado. Las columnas del reporte son; Imagen, Código de producto, Cantidad a mano y Fecha de Creación/Fecha de Modificación(i.e. fecha en la que un ítem para el producto fue agregado al catálogo y la fecha en la que un ítem fue modificado por última vez). El reporte es mostrado en el panel Preview. El panel Preview tiene una barra de herramientas Preview. Para más detalles sobre los botones de esta barra de herramientas haga clicK en el tópico de ayuda Barra de herramientas Preview.

Reporte de Detalles de Producto



Hacer click en Reports > product details muestral un submenú listando todos los reportes de Detalles de Producto disponibles. Si no se ha creado ningún reporte de Detalles de Producto el submenú muestra una sola opción de Todos los Productos.

El reporte de Detalles de Producto muestral información detallada para los productos seleccionados en el reporte. Usted puede escoger los campos que serán incluidos en el reporte. El reporte será formateado en forma de etiqueta, con una etiqueta para cada producto en el catálogo.

Para visualizar el reporte de Detalles de Producto: 

1. Haga click en Reports > Product Details y seleccione el reporte que usted desea visualizar desde el submenú.

Esto muestra el cuadro de diálogo de Personalizar el  Reporte el cual tiene cuadros de selección para los diferentes campos utilizados para guardar información de producto para cada producto.
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2. Seleccione  los cuadros para los campos que usted desea incluir en el reporte.

3. Haga click en el botón Aceptar para mostrar el reporte o en Cancelar para no mostrar el reporte.

El reporte es exhibido en el panel Preview. El panle Preview también tiene una barra de herramientas Preview. Para detalles sobre los botones de esta barra de herramientas, haga click en el tópico de ayuda Barra de herramientas Preview.

Opción de Catálogo de Producto en el Menú de reportes



Hacer click en  Reports > Product Catalog muestral un submenú listando todos los reportes disponibles de Catálogo de Producto. Si ningún reporte nuevo de sumario es creado el submenú muestra una sola opción de Todos los Productos.

El catálogo de producto es exhibido en el panel Preview y muestra la imagen principal del  producto, su código de producto y precio. El encabezado del reporte muestra el nombre de la empresa, dirección e información de contacto. El panel de Preview también tiene una barra de herramientas Preview. Para más detalles sobre los botones en esta barra de herramientas, haga click en el tópico de Barra de herramientas Preview.

Creando y Modificando Reportes



Usted puede utilizar el cuadro de diálogo Nuevo reporte para crear un nuevo reporte. Cuando crea un nuevo reporte usted ingresa un título de reporte, tipo de reporte y selecciona los productos a ser incluidos en el reporte.

Creando un nuevo reporte

1. Haga click en Reports > New Report para mostrar el cuadro de diálogo Nuevo Reporte.
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2. Ingrese un nombre para el reporte en el campo Título de Reporte.

3. Seleccione un tipo de reporte de la lista drop-down Tipo de Reporte.

Los tipos de reporte disponibles son Sumario de Producto (muestra Código de producto, nombre, imagen, cantidad y la fecha en la que el producto fue agregado al catálogo), Detalle de Producto (usted puede seleccionar los campos a ser mostrados en el reporte) y Catálogo de Producto (muestra el nombre del producto, imagen y precio).

4. Seleccione el programa de precios cuyo precio será mostrado en el reporte.

5. Agregue líneas de producto cuyos productos usted desea que sean incluidos en el reporte de la lista de Todas las Líneas de Producto a las Líneas de Producto en la lista de Reporte.

6. Haga click en Preview para obtener una vista previa del reporte.

7. Haga click en el botón Guardar.

Modificar Reporte



Usted puede modificar un reporte para cambiar el título del reporte, tipo de reporte (sumario, detalles o catálogo) o el contenido del reporte (líneas de producto) utilizando la opción Modificar Reporte en el menú de Reportes.

Modificando un Reporte

1. Haga click en Reports > Modify Report y seleccione el reporte que usted desea modificar.

El cuadro de diálogo Modicar Reporte es exhibido.
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2. Modifique los valores en los campos del cuadro de diálogo para modificar el reporte.

Para más detalles sobre los campos véase, Reportes Nuevos.

Eliminar Reporte


Usted puede eliminar el reporte que usted ha creado haciendo click en Reports > Delete report y luego seleccionando el reporte a ser suprimido del submenú, el cual aparece. Haga clic en Si en el cuadro de mensaje que aparece para suprimir el reporte o en No para cancelar la supresión.  
Barra de herramientas Preview


[image: image125.png]


  Imprimir: Haga click en este botón para enviar el reporte a la impresora.

[image: image126.bmp] Zoom Adentro: Haga click en este botón para hacer zoom al reporte en el panel preview. Cada vez que este botón es hecho click el reporte es agrandado.

[image: image127.png]


 Zoom Afuera: Haga click en este botón para hacer zoom en el reporte en el panel preview. Cada vez que este botón es hecho click el reporte se achica.

[image: image128.bmp] Encaje a pantalla: Al hacer click en este botón se ajusta el tamaño del reporte para que una sola hoja de reporte encaje en la pantalla completa.

[image: image129.bmp] Encaje al ancho: Al hacer click en este botón se ajusta el ancho del reporte tanto que ocupa el ancho entero del panel preview.

[image: image130.png]


 Escala: Usted puede seleccionar un valor de la lista, el cual decide el agrandamiento del reporte en el panel preview. Los valores en la lista están entre 10% y 500%.

Anterior: Haga click en este botón para ver la página previa de reporte.

Siguiente: Haga click en este botón para ver la siguiente página de reporte.

Ayuda: El hacer click en este botón muestra ayuda en la barra de herramientas Preview.

Personalizar el Reporte
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El cuadro de diálogo Acondicionar Reporte tiene cuadros de selección para diferentes campos utilizados para guardar información de producto para cada producto en el catálogo. Seleccione los cuadros para los campos que usted desea incluir en el reporte. Haga click en el botón Aceptar para mostrar el reporte o en Cancelar para no mostrar el reporte.

Opciones de Menú de ayuda



El Menú de Ayuda del programa CatGen tiene dos opciones: Contenido y Aceca de.

Contenido

Haga click en la opción Contenido en el menú Ayuda y se exhibirá la ventana Ayuda para el programa CatGen. La ventana ayuda tiene dos pestañas: Contenido e Indice. La pestaña de Contenido provee una tabla de contenido organizada como tópicos y subtópicos.

Pestaña de Contenido en Ayuda CatGen

1. Haga click en la pestaña de Contenido en la ventana de ayuda.

2. Haga doble click en cualquier tópico para ver ya sea la lista de subtópicos bajo él o la ayuda sobre ese tópico en el panel de contenido.

Pestaña de Indice en la Ayuda CatGen

1. Haga click en la pestaña de Indice en la ventana de ayuda.

2. Escriba el ítem para el cual desea ayuda en el campo Escriba la palabra clave para encontrar. 

Los tópicos relacionados con el tema que usted escribió son mostrados en la lista de tópicos.

3. Para ver ayuda sobre un ítem, seleccione el ítem en la lista de tópicos y haga click en el botón Mostrar o solo haga doble click en el ítem en la lista de tópicos.

Acerca de
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El hacer click en Help > About exhibe el cuadro de diálogo Acerca de, el cual muestra la versión del programa CatGen que usted está corriendo. Nuevas versiones de este programa están siendo lanzadas con modificaciones y mejoras. Un número de versión identifica cada versión. Para actualizar su programa CatGen a la última versión, seleccione la opción Actualización de Software del Menú Archivo.

Problemas y soporte



Si usted tiene alguna pregunta acerca del Software CatGen, primero consulte a Ayuda CatGen. Si no encuentra lo que necesita, escriba a support@catgen.com
